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Contacting Infor

Contacting Infor

If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and create a support
incident.

The latest documentation is available from docs.infor.com or in the KB article for your version of Infor CRM SLX. For Infor
CRM SLX version 9.4 see KB3565843. For all other versions see KB2289845.

If you have comments about Infor documentation, contact documentation@infor.com.
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Introduction

Introduction

Infor CRM SLX is a leading customer relationship management solution that enables small to medium-sized businesses to
acquire, retain, and develop profitable customer relationships through integrated Sales, Marketing, Customer Service, and
Support automation solutions.

Why Use Infor CRM SLX?

The Infor CRM SLX Web Client helps you manage all aspects of the sales cycle and the customer relationship over the Web.
In addition to tracking contacts, accounts, opportunities, tickets, and activities, users have access to tools for reporting,
automating processes, and creating e-mails and letters using mail merge.

Key Features

The following key features describe how you can use the Infor CRM SLX Web Client:

Contact, Account, and Opportunity Views - Use the Contact, Account, and Opportunity views to manage detailed
information about your contacts, accounts, and opportunities.

Calendar, Activities and History - Use the Calendar to view open and completed activities and events. Use the Activities
view to manage such daily activities as scheduling phone calls, meetings, and to dos.Use the History List view to viewand
manage your history, including completed activities, notes, literature requests, reports, emails, and database changes. If you
have additional access rights, you can also view other Infor CRM SLX users' history.

Lookups - Use lookups to search for records or build groups. Lookups enable you to filter your record list, and then save the
results as a new group. Lookup options vary by record type.

Groups - Use groups to organize your contacts, accounts, opportunities, tickets, and other data based on common
characteristics. Groups can be used for reporting, mail merges, and more.

Campaigns and Leads - Use Leads to develop and qualify new Contacts and Accounts. Use the Campaign functions to
combine advertising, public relations, sales promotion, and selling activities to achieve sales or marketing goals.

Mail Merge - Use Mail Merge when you need to communicate with leads, contacts, or contacts associated with accounts,
opportunities, sales orders, quotes, contracts, returns, or tickets.

Key Performance Indicators (KPIs) - are defined for some list views. These KPIs are calculated using the current list of
records, based on the group and any filters that have been applied. The KPIs do not display until you select which KPIs you
want to display.

Reports and Analysis - Use Reports and filters to summarize information about your contacts, accounts, opportunities,
contracts, and tickets. The Infor CRM SLX Dashboard view allows you to display performance and analysis information in a
dashboard format.
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Customer Service and Support - Use tickets to track, qualify, and resolve customer questions and issues. You can track
time spent working on a ticket through Punch in/Punch out, create ticket activities that are charged against the customer’s
service contract, and schedule calendar activities. The Service and Support features also provide a means of tracking
defects in products or services, and include a return process.

Literature Requests - Use literature requests to schedule sending marketing material or other documents to contacts.
Literature requests are generally paper materials that must be mailed.

Library - Use the Library as a central repository for your company information. The Library often contains items such as
product information, sales literature, and presentations.

Workflows - Workflows allow you to define and execute workflows within the Infor CRM SLX Web Client application. There
are two kinds of workflows, ION Workflows and CRM Workflows. Both use a trigger mechanism to start the workflows based
on changes to Infor CRM SLX data.

Processes - Use processes to execute a series of tasks in a specific sequence over a set time period. The Infor CRM SLX
Web Client offers Sales Processes and Contact Processes.

About This Guide

The purpose of this guide is to help you begin using the Infor CRM SLX Web Client. This guide uses scenarios to
demonstrate how to use the Infor CRM SLX Web Client for many of your daily tasks.

If your company has customized the Infor CRM SLX Web Client, the number, order, and appearance of dialog boxes and
screens may be different than described. See your system administrator for more information.

@ The Help symbol precedes online Help topic names where you can find additional
information.

Related Documentation

= Infor CRM SLX Quick Reference for the Web User card provides commonly used buttons, e-mail configuration
options, and tips for working with groups and Outlook Integration. The Infor CRM SLX Quick Reference card is
accessible from the Help menu.

= The Infor CRM SLX Web Client Help provides detailed information about all of the features available over the Web,
including additional information about Send to CRM and Mail Merge.

Help is available in each Infor CRM SLX application. Additional resources and documentation are available in the KB article
KB3565843 and from docs.infor.com. For all previous Infor CRM SLX versions see KB article KB2289845.
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Chapter 1 Understanding the Infor CRM SLX Web Client Workspace

Chapter 1
Understanding the Infor CRM SLX Web Client
Workspace

Take a few minutes to learn some of the Infor CRM SLX Web Client basics. It will help you become familiar with the
workspace and navigation features.

In this chapter, you will learn to:

Log on to the Infor CRM SLX Web Client

Understand the Infor CRM SLX Web Client workspace

Install and use the Infor CRM SLX Mail Merge for Microsoft Word add-in
Install and use Xbar for Microsoft Outlook

Get more help

Signing in to the Infor CRM SLX Web Client

Before you begin, locate your User ID and password. If you do not have this information, contact your system administrator.

To log on

1.

Connect to your company's Web Client. If you have Windows Authentication configured, then will not complete the
remaining steps, but will be automatically logged on the Infor CRM SLX Web Client.

This can be done several ways, depending on your browser. In many browsers, it is faster to set the initial screen as
the default screen of your browser, or to add the initial screen to a list of favorite sites.

Specify your User ID and Password.

Passwords are case-sensitive. In addition, your system administrator may set restrictions on using blank passwords,
your user name as a password, and other options. If necessary, see your system administrator to discuss your
password options.

If necessary, change the language setting.

Changing the language will cause the Infor CRM SLX Web Client to display in your selected language. If you do not
select a language, then the Infor CRM SLX Web Client will use the default language. The list of languages is based
upon the languages supported by your organization.

= Click the drop-down arrow and select a language from the list of supported languages.

""" If your implementation uses Windows Authentication and you do not sign in to
the Infor CRM SLX Web Client, you can also select a language from the options
User Profile tab.

Click Sign In.

If Multi-Factor Authentication is configured you must complete additional steps for setting up and using the available
Multi-Factor Authentication options. See "Signing in with Multi-Factor Authentication" for more information.
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To log off

= |n the lower-right part of the browser window, click Sign Off.

Signing in Using Multi-Factor Authentication

If this is your first time signing in using Multi-Factor Authentication, you must set up your authentication method.

""" If you plan to use an authenticator application you must first have access to that
application on your mobile device.

After signing in, you can manage your Multi-Factor Authentication method methods from the Tools menu, Options, Multi-
Factor Authentication tab. See “Multi-Factor Authentication Options”.
To sign in with Multi-Factor Authentication
1. On the Infor CRM SLX sign in page type your user name and password and set your language and regional options.
Click Sign In.

3. If you have not set up an authentication method, then you must first set up a Multi-Factor Authentication method. If
you already have set up an authentication method, then proceed to step 4.

a. Click Next.
b. Inthe Name box type a descriptive name for your authentication method.

c. Click the Authentication Method drop-down arrow and select from the list. The options available depend on
what your administrator has implemented, but may include:

i. Email
ii. Authenticator Application
d. Click Next.
e. The next step depends on your authentication method.
» Ifyou selected Email in step 3c:
o Proceed to step 4 and follow the instructions for Email authentication.
» If you selected Authenticator Application in step 3c:

a. Open your authenticator application, add a new account and either scan the provided QR code
or type the provided code that displays below the QR code.

b. Click Next and follow the instructions for Authenticator Application in step 4.
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4. The next step depends on your authentication method.

= |f you set up Email authentication:

a.

d.

If necessary, click the Name drop-down arrow and select the name of the email authentication method
you want to use to sign in.

Click Send Email Code.

Go to the email inbox associated with your Infor CRM user email address. When you receive the Multi-
Factor Authentication email, copy the Multi-Factor Authentication code and paste it into the TOTP
Code box.

Make sure to remove any leading or trailing spaces which may cause the authentication to fail.

Click Continue.

= |fyou set up an Authenticator Application:

a.

If necessary, click the Name drop-down arrow and select the name of the authenticator application
method you want to use to sign in.

In the TOTP Code box type the authentication code provided in the authenticator application you
selected in step a.

Click Continue.

Working in the Infor CRM SLX Web Client

The workspace is the area where various views appear in the main Infor CRM SLX Web Client.

Status Bar

Some features require you to enable pop-ups. See your browser help for specific
instructions on how to allow pop-ups.
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Figure 1 Infor CRM SLX Web Client Workspace
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Understanding the Workspace Features

Each view in your Infor CRM SLX Web Client contains many of the following elements.

Your workspace may be different depending on your access rights or if your
installation has been customized.

(Element _______Descripton |

Title Bar The title identifies the active view. When you are in a detail view, the title bar
displays the name of the current record.

Navigation Bar Located on the left side of the Infor CRM SLX Web Client workspace, the
Navigation Bar contains buttons that open the main Infor CRM SLX Web Client
views.

The Navigation bar can be docked or hidden. If you cannot see the Navigation
Bar, click the = icon in upper left corner of your workspace.

To dock the Navigation bar, so that it always appears, click the™ icon. To hide
the Navigation Bar, click the "' icon.

Your administrator can group the buttons into Navigation Group subsets that
focus on specific elements of your business, such as Sales or Support. For
example, the Support group contains Contacts, Tickets, Defects, Activities,
Calendar, and Reports.

Click the navigation heading to show or hide the iitems listd below the heading.

Menu Bar The menu bar contains the Infor CRM SLX Web Client commands.These
include Recently Viewed, New, Schedule, Log, Tools, Compose, Theme, Past

Due 0 Alerts Q\ Job Notification 0 SpeedSearch, and the Help button.
Click a menu to expand it.

Lookup The Lookup button, located to the left of the group tabs in most list and detail
views, allows you search from records using one or more search conditions.

Speed Search SpeedSearch helps you find information stored in the Infor CRM SLX database.

For example, you can search through existing tickets or procedures to help
solve a customer's problem, or search for a specific document, like a

presentation.

Tabs Tabs organize information on many of the list views, detail views and dialog
boxes.

Pick Lists A pick list is a set of values you can select from when entering data. Pick lists

are useful because they encourage consistent data entry. Your access rights
determine if you can add, edit, or delete pick list items. To open a pick list, click
the drop-down arrow in the box.

Task Pane The Task Pane displays to the right of the main window pane. The Task Pane
consists of filters, common tasks and other features designed to help you
complete your work. The available options depend on the record type and type
of view where you are working.

Status Bar The status bar displays the user, date, time zone and Log Off button
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Setting Themes and Modes

Use the Themes menu to personalize the appearance of your workspace.
1. Select Theme from the menu bar.
2. Do any of the following:

= Point to Modes and then select Light, Dark, or High Contrast.
This option determines text and background appearance.

= Pointto Colors and select a color theme. The color theme determines the menu bar, title bar, section
headings, and highlight colors.

Using List Views

List views display information in a list with columns and rows of information. Each tab in the list view contains a group of
contacts, accounts, opportunities, or tickets and so on.

® You can customize your list view groups by adding or removing columns, changing the column order and adjusting
column widths.

a See "Customizing List View Groups" in the Web Client online Help for more
information.

= Clicking a column header sorts the information in that column. The arrow marker indicates whether the column is
ascending or descending.

®m Key Performance Indicators, or KPIs are defined for some list views. These KPIs are calculated using the current list
of records, based on the group and any filters that have been applied. The KPIs are not displayed until you select the
KPIs you want to display. To select KPlIs, click the Manage KPIs icon , select the check boxes of the KPlIs to be
displayed and click Save. For more information, see "Working with List View KPIs" on page 85.

If KPIs are not available on the list view, a "No metrics defined for this list view" message is displayed
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Using Detail Views

Most records in Infor CRM SLX display information in bo
information boxes, tabs, and a user-defined middle secti

®  The upper section shows basic information abou

th a List view and a Detail view. The Detail view consists of
on.

t the selected record. When you add a new record, dialog boxes

guide you through entering the information that appears in the Detail view. To edit information, click the box you want

to change.

= The middle section is called the user-defined are
To move a tab to the middle section, click one of

a. You can use this area to keep the tab you use most often visible.
the tabs in the bottom section, hold the mouse button, and drag the

tab to this area. The tab will remain open in the user-defined area each time you use the Infor CRM SLX Web Client.

If you want to change the tab in the middle sectio

= The lower section contains a group of tabs. Each

system administrator can create custom tabs for
you want to appear in the grid and clear the chec
move your mouse cursor off of the menu and clic

u:}, RecentlyViewed New Schedule Log Tools Administration Theme Compo:

n, select another tab and drag it to replace the current tab.

tab shows specific information you need for the related record. Your

your company. Click the © and select the check box of the columns
k boxes of the columns you want to hide in the grid. When finished,
k to close the menu.
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Understanding the available buttons

Many features in the Infor CRM SLX Web Client are accessed through buttons. The following list shows each of the buttons
available, and describes the action each button performs. When you drag your mouse across a button in the Infor CRM SLX
Web Client, a tool tip explaining the button function appears. Buttons are referred to by their tool tip.

©

Accepted

Account Service information

Add, Associate

Add/Remove Column

Add Account/Contact

Add Condition

Add Custom Product

Add File

Add Step

Add URL

Alarm

Alerts

Indicates an activity
has been accepted.

Click this button to
open the Account
Service Information
dialog box.

Click this button to
add an item.

Click this button to
add or remove grid
columns in a list view
or tab.

Quickly add an
account and contact
when creating a
quote or sales order.

Click this button to
add another
parameter to the
Lookup on the List or
Detail views.

Click this button to
add a custom
product to a sales
order orquote.

Click this button to
attach afile.

Click this button to
add a step to a CRM
Workflow.

Click this button to
attach a Web
address URL.

In the Activities list
view, identifies if an
activity has an alarm.

Click this button to
view activities with
triggered alarms and
unconfirmed
activities.
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Button Tool tip or Description Event
(/] Approve (CRM Workflow step) Identifies a CRM
Workflow Approve
step.
= Associate Click this button to
associate an item.
@ Attachment In the Activities list

view, identifies if an
activity has an
attachment.

Branch Identifies a CRM
Workflow Branch
step.

4 Business Rule Identifies a CRM
Workflow Business
Rule step.

Calendar Click this button to

select a date and
time.

oo

Camera Click this button to
take a forecast
snapshot.

Clear Click this button to
clear a lookup
selection.

X b =

. Collapse Click this button to
hide additional
information in a list
row.

Complete Click this button to
complete an activity.

[

Copy Information to the Clipboard Click this button to
copy contact
information to the
Clipboard.

[ Create Activity Identifies a CRM
Workflow Create
Activity step.

Create Entity Identifies a CRM
Workflow Create
Entity step.

Create History Identifies a CRM
Workflow Create
Entity step.

Pl
i 1
bpmd

_|_

(<

B

Database Change Indicates the history
record type is a
database change.
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Button Tool tip or Description Event

@ Declined Indicates an activity
has been declined.

Ij Delete Click this button to
delete an item.

E] Document Indicates a history
item is a mail merge
Document.

- Down Click this button to

move a product
below another
product to change
the order on the
Opportunity, Quote,
or Sales Order
Products tab.

Duplicate Click to create a copy
of arecord to create
anew record.

al

f Edit Click this button to

— edit information.

ED Edit Form Click this button to
open the Web Form
Designer.

Only users with the
appropriate role can
access this feature.

@ Edit Step Click this button to
edit a CRM Workflow
step.

" Ellipsis Click this button to
open a multi-select
pick list.

B E-mail Click this button to

open a new e-mail
message.

Indicates a history
item is a sent email.

- Expand Click this button to
view additional
information in a list
row.

e Filter Click this button to
- filter a list of records.

Q Find Click this button to
perform a lookup.

| < First Click this button to
view the first record
in a group.
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Button

>l

S

Tool tip or Description
Help

Job Notification

Last

List View

Literature

Mail Merge

Map

Maximize pane

Meeting

Merge

Event

Click this button to
open Web Client
Help.

Click the drop-down
arrow to display
notification details
and to access the
result of your job.
The number next to
the icon shows how
many jobs are
available for you to
view.

Click this button to
view the last record
in a group.

Click this button to
switch to the list view.

Indicates the history
record type is a
literature request.

Indicates mail merge
step in a customer
journey.

Click this button to
open a map using the
current address
information.

If Contour integration
is enabled and
configured it will
open a map using the
Contour provider. If a
provider is not
configured then the
address will open in
MapQuest.

Click this button to
maximize the size of
the window pane.

Identifies a meeting
or meeting step, or
click this button to
schedule a meeting
from the Activities
tab.

Click this button to
merge two contacts
on an Account detail
Contacts tab.
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Button

(<]~

= oy @

(b

&

=

Tool tip or Description
Minimize pane

Move Contact

Next

None

Note

Open Windows Explorer

Past Due

Personal Activity

Phone Call

Previous

Promote

Recurring

Refresh

Event

Click this button to
minimize the size of
the window pane.

Click this button to
move a contactto a
different account.

Click this button to
view the next record.

Indicates a "none"
step in a customer
journey. A none step
does not have an
action, itisa
checklist item.

History item is a Note
or a note step.

Click this button to
open Windows
Explorer to select a
file or folder.

Click this button to
open the Acitvities
view Past Due tab.

Identifies a personal
activity, or click this
button to schedule a
meeting from the
Activities tab.

Identifies a phone
call or phone call
step, or click this
button to schedule a
meeting from the
Activities tab.

Click this button to
view the previous
record.

For Back Office
Integration only.
Click this button to
promote arecord to a
back office
application.

Identifies that an
activity is part of a
recurring activity
series.

Click this button to
refresh the list of
records in a list view.
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Button Tool tip or Description Event
pzﬁ Remove association Click this button to
remove an

association between
two records. For
example, to remove
a product from an
opportunity.

— Remove Condition Click this button to
remove a parameter
from the Lookup on
the List or Detail

views.
i) Report Indicates a history
item is a Report.
) Reset Click this button to
clear any changes

you've made since
the last update.

B Save Click this button to
save your changes.
= Save & Clear Click this button to

save the current
record and clear the
information in order
to insert a new
record.

Save & New Click this button to
save the current
record and retain the
account information.

E Send Email Identifies a CRM
Workflow Send Email
step.

E Send to Email Click this button to
open an email
message with the
contents of the note
or history copied and
pastedin the
message.

B Send to Word Click this button to
open a Microsoft
Word document with
the contents of the
note or history copied
and pasted in the
document.

+ -
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Button

I ® ¥ @

> ®

()

Tool tip or Description

Share

SpeedSearch

Start

Start New Workflow

Stop Workflow

Sync or Sync Enable

Sync Disable

Test Condition

To Do

Unconfirmed

Up

Update Entity

Update Target

User Date Stamp

Event

Click this button to
share a place in
Contour.

Click this button to
open SpeedSearch.

Identifies a CRM
Workflow Start step.

Identifies a CRM
Workflow Start New
Workflow step.

Identifies a CRM
Workflow Stop
Workflow step.

Click to starta
manual
synchronization or
enable
synchronization.

Click to disable
synchronization.

Identifies a CRM
Workflow Test
Condition step.

Identifies a to do, or
click this button to
schedule a meeting
from the Activities
tab.

Indicates an activity
has not been
accepted or declined.

Click this button to
move a product
above another
product to change
the order on the
Opportunity, Quote,
or Sales Order
Products tab.

Identifies a CRM
Workflow Update
Entity step.

Click to update the
campaign target list.

Click this button to
put a user name and
date stamp in your
ticket notes.
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Button Tool tip or Description Event

View Parent/Child Hierarchy Click to view an
account’s parent and
child relationships to
other accounts.

e

Workflow Indicates workflow
step in a customer
journey.

WWwW Click this button to go
to a Web site.

Zoom In Click this button to
zoom in closer in the
workflow on the CRM
Workflow Designer
tab.

Zoom Out Click this button to
zoom out closer in
the workflow on the
CRM Workflow
Designer tab.

Zoom Reset Click this button to
reset the zoom to
100% in the workflow
on the CRM
Workflow Designer
tab.

£ O A

I':'I
-

L

Searching for Information

Use SpeedSearch to set up your search criteria and start a search. How you set up the search criteria determines how and
where SpeedSearch locates items matching the keywords you enter.

To search for information

1. Inthe menu bar, click the SpeedSearch drop-down arrow and select the check boxes of the record types you want to
search.

= Your previously selected options remain selected until you clear them.

= |fyou are in a list or detail view, and SpeedSearch is set up to search against the record type, the in focus
record type will automatically be selected to search.

= Your most frequently used options are listed under Most Frequently Used.

2. Type your search criteria in the SpeedSearch box. As you type, a list of matching options displays below based on
the selected record types.

3. ClickQ (SpeedSearch).
SpeedSearch opens with your search results.
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4. View the search results for each of the selected record types and do any of the following.

= Hover the mouse over the number link in the Matches column to see the matching information.

= Click the Name column link to open the detail view of the record.

= Click the Minimize icon to collapse the results of any record type. To expand the results, click the Maximize

icon.

5. If necessary,

under Options make changes to any of the following to update your search criteria:

= Change the number of records to display for each record type: In the Maximum Results box, click the drop-
down arrow and select an option from the list.

= Change the Search Method: Click the Search Method drop-down arrow and select one of the following

options

Match on all words (AND) — The search only locates items containing all of the keywords but they do
not have to appear together in the record/document. The search ignores words like "and", "the", and

a.

Match on any word (OR) — The search locates items containing at least one of the keywords you
entered.

Match the exact phrase — The search only locates items containing all of the keywords appearing
together exactly as you entered them in the Keywords box.

Boolean (AND, OR, NOT) — The search uses straight search logic to locate items containing the
keywords; words like "and", "the", and "a" are included if you type them in the Keywords box.

Natural Language — If you type a sentence in the Keywords box and this option is selected, the search
interprets the sentence to determine which keywords to locate. Natural language searches may take
longer than other searches.

®  Select or clear the search options.

Root — The search looks for root words in addition to any keywords you entered containing prefixes,
suffixes, or alternate verb forms. (For example, if you entered "printing" it would also search for "print".)

Thesaurus — The search looks for synonyms in addition to the keywords you entered. (For example, if
you entered "customer”, it would also search for "client".)

Sounds Like — The search looks for words that sound similar to the keywords you entered. (For
example, if you entered "Smith", it would also search for "Smythe".)

If you use the Match the exact phrase search method and any of the three options: Root,
Thesaurus or Sounds Like, there is a possibility that the search may return more records
than you intended. In order to find specific records, use large phrases with more descriptive
words and clear the three check box options.

6. When finished you can navigate to another view by clicking a link in the results or use the menus or navigation bar.

Getting He

Ip

Information on advanced features and areas not covered in this guide is available in the Infor CRM SLX Web Client online

Help topics.

To access online Help

" Click the Help button ? .
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Log on to the Infor CRM SLX Web Client. Logging on to the Infor CRM SLX Web Client
Find out what new features have been added to the Infor What's New in This Release

CRM SLX Web Client.

Find useful tips for first-time users. New User Tips

Use Alerts to help me manage my activities. Using Alerts

Customize the Infor CRM SLX Web Client options for my Editing User Options
personal needs.

Schedule a meeting and invite others. Scheduling or Editing an Activity
Schedule an Event (such as a trade show). Scheduling or Editing an Event

Access an overview of Sales Processes. What are Sales Processes?

Add a campaign response for a campaign target Adding or Editing a Response Information

See your system administrator for answers specific to your Infor CRM SLX installation.

Understanding Infor CRM SLX Mail Merge for Microsoft Word

The Infor CRM SLX Mail Merge for Microsoft Word add-in provides support for Mail Merge in Microsoft Word,including
creating and managing templates and performing mail merges output to file, print, or email.

Installing Mail Merge for Microsoft Word

Before you can use Mail Merge for Microsoft Word you must install the Infor CRM SLX Mail Merge for Microsoft Word add-in.

To install the Mail Merge for Microsoft Word add-in

1.

11.
12.
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Close Microsoft Word.

On the Tools menu, click Options.

Click the General tab.

Click Install Mail Merge for Microsoft Word.

Open the InforCRMWordAddinSetup.exe from your Downloads folder.
Select the | agree to the license terms and conditions check box.
Click Install.

If prompted, click Yes to confirm that you want to install the add-in.

Click Close.

Open Microsoft Word.

If prompted "Are you sure you want to install this customization?" click Install.

Once installed, you must set Infor CRM SLX Options.

Setting Infor CRM SLX Options

Use the Connection options to set up your connection to the Infor CRM SLX server.
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These options are configured for users who set these options for Infor CRM SLX Xbar
for Microsoft Outlook.

To set Connection options

1.

In Microsoft Word, on the Mailings tab, click the Infor CRM SLX Options button and, if necessary, click
Connection.

In the SData URL field, specify the server name and SData portal.

= Specify the SData URL that your administrator provided in order to connect to Infor CRM SLX. Use the
following format: http://servername:port/sdata or https://servername:port/sdata

= Offline Web Client users - Specify the URL to connect to your local Infor CRM SLX server. Use the following
format: http://localhost:port/Sdata The port is usually 8088.

If your implementation does not use the standard SIxClient portal for the Web Client, then in the Web Client URL
field, specify the server name and Web Client portal.

This is automatically completed for you if your implementation uses the standard SIxClient portal, and no changes
are needed.

= Specify the URL that your administrator provided in order to connect to the Infor CRM SLX Web Client. Use the
following format: http://servername:port/<portal name> or https://servername:port/<portalname>

= Offline Web Client users - Specify the URL to connect to your local Infor CRM SLX Web Client Use the
following format: http://localhost:port/<portal name> The port is usually 8088.

If you use your Windows account information to log in to Infor CRM SLX, select the Use Windows Authentication
option, otherwise leave this option cleared.

Specify the User Name and Password you use to sign in to Infor CRM SLX. This is your Infor CRM SLX or Windows
user name and password.

""" If your implementation uses Infor OS, you must not enter your credentials in this
dialog box. You are prompted to enter your Infor OS credentials.

Click Test. If the test fails, review your connection information. If the information is correct and you still cannot
connect, contact the administrator.

Click OK when you are finished setting your options and your connection test is successful.
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Understanding Infor CRM SLX Integration with Microsoft Outlook

Outlook Integration features are now installed with Infor CRM Xbar for Microsoft
Outlook.
The Infor CRM SLX Xbar for Microsoft Outlook installation provides support for:

= Xbar

= Access key contact information, activities and opportunities in Infor CRM SLX from Outlook e-mail
correspondence or calendar activities.

= Create new contacts, accounts and opportunities by dragging and dropping existing information from e-mail
into the Xbar interface.

=  Make changes to contact, calendar, and interaction history in Xbar that automatically updates within Infor CRM
SLX.

For more information about Xbar for Outlook features, please refer to the Xbar help. Click the = icon to open
the Global menu and access the help file.

""" Field level security defined in the Infor CRM SLX Web Client Security
Manager applies to Infor CRM SLX Xbar for Microsoft Outlook version 1.3.7
or later.

= Qutlook Integration
= Record email messages to history
= |ntegrate with the Microsoft Outlook Address Book
®  Drag and Drop E-mail from Microsoft Outlook
= Send an Infor CRM SLX contact's information in a vCard file format via e-mail
= Attach documents from Infor CRM SLX Library to a message in Outlook
= |nfor CRM SLX Activity Task Pane
= Using Outlook Synchronization allows you to synchronize:
= Contacts
® |eads

= Calendar
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Installing Infor CRM Xbar for Microsoft Outlook

Outlook Integration features are now installed with Xbar. Before you can use any of these features you must install Infor
CRM Xbar for Microsoft Outlook. For more information about installing Infor CRM SLX Xbar for Microsoft Outlook, please
contact your administrator.

To install Infor CRM Xbar for Microsoft Outlook from the Infor CRM SLX Web Client
1. Do one of the following:
= |fyou are an [[[Undefined variable MyVariables.Infor CRM]]] Web Client user:

a. Signin to the [[[Undefined variable MyVariables.Infor CRM]]] Web Client, expand the Tools menu
and then click Options.

b. Inthe Options window, click the General tab, and then click Install Xbar for Outlook.
The Infor CRM Xbar Setup.exe is copied to your download folder.
= |fyou are an [[[Undefined variable MyVariables.Infor CRM]]] Windows Client user:

a. Browse to the location provided by your Infor CRM Administrator and copy the [[[Undefined variable
MyVariables.Top Zip]]] to any convenient folder.

« Ensure you have Write permissions to the folder where you are saving the zip file. You can
check permissions on the Security tab on the folder properties.

« Ensure the folder path is as short as possible, as there is a 57 character limit.
b. Extract the zip file.
Click [[[Undefined variable MyVariables.Exe]]], and then click Install.
Click Setup.exe.
Click Run, and then click Install.
After the Microsoft Office Customization Successfully Installed message appears, click Close.
If prompted to allow Infor CRM Xbar to make changes to your device, click Yes.

After the Setup Successful message appears, click Close.
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If the Infor CRM Desktop Manager screen opens, click the help button and browse to the help topic called Setting
Desktop Manager Database Information and History Options for instructions on setting up Desktop Manager to
connect with your installation of Infor CRM.

9. Start Microsoft Outlook.
10. InInfor CRM Connection Options, click the Connection tab and complete the following.
a. Inthe Server field, specify your server name.

o Infor CRM SLX Client and Infor CRM SLX Web Client users - Type the URL that your administrator
provided in order to connect to Infor CRM SLX. Use this format:
http://servername:port or https://servername:port

« Offline Web Client users - Type the URL to connect to your local Infor CRM SLX server. Use the
following format:
http://localhost:port
The port is usually 8088.
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b. Do one of the following:

« Use Windows Authentication: Select this check box if you use your Windows user name and
password to sign in to the Windows or Web Clients.

Windows Authentication must be configured by your Administrator. If you do not
know if Windows Authentication is configured for your organization, contact your
Administrator.

» Specify your [[[Undefined variable MyVariables.Infor CRM]]] User Name and Password:

« User Name: Type your username. This is the username you use to sign in to the [[[Undefined
variable MyVariables.Infor CRM]]] Clients.

If your implementation is integrated with Infor OS, then you use your Infor
OS username to sign in to [[[Undefined variable MyVariables.Infor CRM]]].

o Password: Type your password. This is the password you use to sign in to the [[[Undefined
variable MyVariables.Infor CRM]]] Clients.

If your implementation is integrated with Infor OS, then you use your Infor
OS password to sign in to [[[Undefined variable MyVariables.Infor CRM]]].

c. Click Test.
If the test fails, review your connection information. If the information is correct and you still cannot connect,
contact the administrator.

d. Inthe Connect the Go To CRM button to section, select the Infor CRM SLX client you use.

« If you use the Infor CRM SLX Windows Client, select the Infor CRM Windows Client option.
This option is unavailable if the Infor Windows Client is not installed.

« If you use the Infor CRM SLX Web Client, select the Infor CRM Web Client option and then if
necessary, in the URL field, specify the URL that the administrator provided in order to connect to Infor
CRM SLX. Use this format:
http://servername:port/sixclient or https://servername:port/sixclient

11. If you are upgrading an existing installation of Xbar, you may be automatically signed into Xbar using your prior
credentials. Should you need to use different credentials, you can do so by expanding the 'Global’ menu, clicking
Settings, and making your changes in the Server Configuration screen.

Configuring Outlook Integration

Outlook integration preferences should be configured in Microsoft Outlook.
Before you can configure Outlook:
= Microsoft Outlook must be installed and running on the local machine.

= Web - Infor CRM SLX Xbar for Microsoft Outlook will not install unless Microsoft Office, including Outlook, is
already installed.

= Advanced - To enable drag and drop from Outlook to Infor CRM SLX Web Client using all browsers.

® You must know the connection server and port number and your user name and password.
Contact your system administrator for more information.
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To configure

1.
2.

Open Microsoft Outlook.

If you are not prompted, click the Options button.
If the Options button does not appear, then Outlook Sync has not been installed properly.

Use the tabs to set the following options:

Connection - connection to the Infor CRM SLX server. Required for contact and calendar synchronization and
e-mail integration.

These options are shared with the Infor CRM SLX Mail Merge for Microsoft
Word add-in and may already be configured if you previously set these
options for the add-in.

Appointment Filters - Defines how appointments are synchronized between Microsoft Outlook and Infor CRM
SLX
Xbar side Panel - set options specific to Infor CRM SLX Xbar For Microsoft Outlook.

Send to CRM/Record to History - options for prompts, displaying information, and attachment behavior when
using Send to CRM or Record to History. Used for e-mail integration.

All Options - ability to view options as value pairs. Recommended for advanced users only.
For more information see the Outlook Sync help topic "Configuring Outlook Sync".

4. Click OK.
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Chapter 2
Managing Contacts and Accounts

This chapter introduces you to the core of Customer Relationship Management (CRM) - working with contacts and accounts.
= Contacts are the key people associated with an account.
= Accounts are your prospects and customers. Accounts can contain one or many contacts.

You can use Infor CRM SLX to manage contact and account information. This includes daily interactions, such as phone
calls, meetings, action items, or other correspondence.

In this chapter, you will learn to:
=  Add a contact and an account
= Create an account association
®m Use the Library
= Schedule a literature request

= Add a note and schedule a follow-up activity

Adding a Contact and an Account

Infor CRM SLX focuses on account relationships. Therefore, all contacts must be attached to an account. Account and
contact information is accessible by any Infor CRM SLX user who has the appropriate security. For example, you can create
an account for Beeker Motors. Your Sales Assistant may not have the required security to access the account, but your
Sales Manager can.

Understanding Account Ownership

Before creating an account in Infor, it is important to understand account ownership.

= The Account Owner has access to an account and can use any account-related activities such as scheduling
activities and running reports. An account owner can be an individual user, a team, or all Infor CRM SLX users.
Access to account data can be different for each user. For example, if a team owns an account, some team members
may have read-only access to the account, while others have read/write access. Security is controlled by your
system administrator.

= The Account Manager is responsible for managing the relationship with the account. This can include follow-up
phone calls, meetings, preparing proposals, and working with the account’s contacts. The account manager is a
single individual.

The individual user designated as the account owner is often also set as the account manager. If a team is the account
owner, a team member will usually be set as the account manager. Account owners and account manager should be
assigned according to your company’s guidelines.

There are several ways to add contacts and accounts to Infor CRM SLX. This guide will explain the most common methods.

Getting Started with the Infor CRM Web Client | 29



Chapter2 Managing Contacts and Accounts

Our scenario:

You met Tom Dale and Joan Smith at a trade show. Tom and Joan (contacts) work for Beeker Motors (account). First
you will add contact Tom Dale to a new account (Beeker Motors); then you will add Joan Smith to an existing account
(Beeker Motors).

To add contacts and an account

1.
2.

11.
12.
13.
14.
15.
16.
17.
18.
19.

On the New menu, click Account/Contact.

In the Contact box, type Tom Dale.

To add hyphenated last names or names with a professional designation, click the Edit button next to the Contact
box. Then use the Edit Name dialog box to specify a name prefix (such as Dr.), first name, middle name, last name,
or suffix (such as C.P.A).

In the Account box, type Beeker Motors.

In the E-mail and Web boxes, add e-mail and Web address information.
= E-mail: tom.dale@beeker.mail
= Web: www.beeker.web

In the Work Phone field, type 5551234512.

Click the Look for Matching Records button.

This searches the database for records that have the same e-mail address, Web address, phone number, and
account. It is important to search for records before adding information. If you do not check for existing information,
you might create a duplicate contact or account.

Click Cancel to close the Matching Records dialog box, or if a duplicate record is found click Open next to a record
to view additional details or Use Account to select a record.

If you select Use Account, the account appears next to the Use Existing Account ... label in the Insert
Contact/Account view.

In the Contact Information area, in the Title box, click the drop-down arrow and select Vice President.

Continue to add Tom’s information in the Contact Information section.

Under Account Information, double-click in the Address box to open the Address dialog box and add the Address
information for Beeker Motors, as follows:

= | eave Description as Office.
= Select Primary to identify this address as the primary address for this account.
= (Click the Address Type drop-down arrow and select Billing & Shipping.
® |nthe Address 1 box type 1234 Gary Parkway
= |n City, State, Postal Code type Oak Park, IL 60305
Click OK.
(Optional) Use the Maps icon to see a map of the address.
In the Main box type 5551234500.
Click the Type drop-down arrow and select Customer.
Click the Status drop-down arrow and select Active.
Click the Industry drop-down arrow and select Automotive/Aerospace.
In the Account Manager box, click the Find button, and then select the account manager.
In the Owner box; click the Find button, and then select an owner.

In the Lead Source box, click the drop-down arrow and select Trade Show.
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20. Click the Save & New button.
This option allows you to add another contact to the existing account.

21. Inthe Contact box, type Joan Smith.
22. Inthe E-mail and Work Phone boxes, add e-mail and Work Phone information.
= E-mail - joan.smith@beeker.mail
= Work Phone - 5551234519
23. Inthe Contact Information area, in the Title box, click the drop-down arrow and select Managing Director.
24. Click Save.

e For more information see the "Adding a New Contact and Account" topic in the
Infor CRM SLX Web Client Help.

If you need to edit a contact or account’s information, you can do so by clicking the boxes on the Detail view and typing in the
changes.

You must click the Save button after making any changes.

Adding an Account Association

Accounts may have a common connection, for example, one company may be a parent of another. You can create a
relationship between accounts by adding an association. This association can be helpful for tasks like running reports. You
can create one report for both accounts rather than two separate reports. Associations can also create opportunities for you
to sell to parent companies rather than subsidiaries.

Our scenario:

Tom Dale told you that Beeker Motors was owned by International Machines. You want to create a parent/subsidiary
relationship between the two accounts.
To associate accounts
1. Open the Beeker Motors Account Detail view.
a. On the Navigation Bar, click Accounts.
b. Click the Lookup tab (magnifying glass).

c. Inthe first box select Account, in the second box select Starting With, in the third box type Be, and then click
Search.

d. Inthelist, click Beeker Motors.

2. On the Beeker Motors Account Detail view, click the Associations tab. If the tab is not visible, click the More Tabs
tab.

Click the Add Association button.
4. Click the Find button (magnifying glass).

5. Inthe Lookup Account box, make sure Lookup Accounts by: shows Account, type Int, and then click the
Search button.

6. Click International Machines in the account list, and then click OK.
7. Click the drop-down arrow below Beeker Motors is a and select Subsidiary.

8. Click the drop-down arrow below International Machines is a and select Parent.
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9. Inthe Description boxes, type a description for each account.
10. Click OK.

Working with the Library

The Library is a central repository for company information. Files are organized into folders and sorted by name. Click the
column headings to sort the library files list.

Your company’s library may include product information, policies and procedures, presentations, Web addresses, and so
forth. Only the administrator and an administrative user can add files to the Library.

Our scenario:

You want to use the Library to find current product information.

To access information from the Library
1. On the Navigation Bar, click Library.
2. Inthe tree view, click the "+" signs to expand the folder that contains the file you want to open.
3. Inthelist, click the File name of the file you want to download.
4. Do one of the following:
= QOpen the file

= Save thefile

e For more information see the "Working with the Library" topic in the Infor CRM SLX
Web Client Help.

Requesting Literature for a Contact

Literature requests involve sending marketing materials or other company documents to one or more contacts. Infor CRM
SLX users or the system administrator manage the available literature. After you schedule a request, the person or group at
your company responsible for literature fulfillment can fulfill and complete the request.

If you are making the request for a single contact, select the contact before you begin the following steps.

Our scenario:

Joan Smith requested information on a specific product at a trade show, but you had run out of brochures. You want to
schedule a literature request to send the information to Joan.
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To schedule

1. Open Joan Smith’s Contact Detail view.

a.
b.
c.

d.

On the Navigation Bar, click Contacts.
Click the Latest Contacts group tab.
In the Task Pane, under Filters, click Name and select S.

In the list, click Smith, Joan.

2. Onthe Schedule menu, click Literature Request.

3. Inthe Description box, enter a brief description of the literature request.

® Type Lenovo ThinkPad sales brochure.

4. To select who the literature request is for, do one of the following:

= To create the request for a single contact, select Contact, click the Lookup Contact button and select a contact.

© ® N o o

Since we scheduled the literature request from Joan Smith's contact detail view, Contact is already populated
with Joan Smith.

To create the request for a group of contacts, select Group, and then click the drop-down arrow and select from
the list.

To create the request for an opportunity, select Opportunity, click the Lookup Opportunity button, use the
lookup to select an opportunity , and then click Close.

Click the Send by Calendar button, select a date, and then click OK.

Select the Handle Fulfillment Locally check box to save the file locally after you schedule the literature request.
In the Send via (delivery method), and Priority boxes, click the drop-down arrow, select FedEx and Medium.
Under Print Literature List, select with cover letter.

Click the Cover Find button, expand Public Templates, expand Letter, select Company Information, and the

click OK.

10. Under Available Items, select the items you want to include in your request.

a.

b.

C.

If necessary, click the Filter available items button and enter any characters contained in the family, number
or name of the item you want to add.

Select Lenovo ThinkPad Brochure.

Double-click in the Quantity column and type the number of copies of that item you want to request. Type 2.

11. Click the Schedule Literature Request (Save) button.

The literature request is recorded on the Literature Requests list view and on the Literature Requests tabs in the Contact and
Account Detail views.

The person assigned by the administrator to monitor Literature Requests will receive your request and should fulfill it by the
date you specified.

Scheduling a Follow-up Activity

In Infor CRM SLX, phone calls, meetings, to-dos, and personal appointments are called activities. Scheduling follow-up
activities can help you organize and remember important events.

Our scenario:

You want to schedule a phone call to follow-up on literature that was sent to Joan Smith.
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To schedule a phone call

1. Open Joan Smith’s Contact Detail view.

2. Onthe Schedule menu, click Phone Call.

3. Inthe Regarding box, click the drop-down arrow, and select Confirm Literature Received.
4. Use the Location field to type a location.
5

In the Start Time box, click the Calendar button to select the date and time when the activity will occur, and then
click OK.

6. Do one of the following:

= Select the Timeless check box to create an activity that occurs on a specific date, but at no specific time and
without a specific duration.
Timeless activities are displayed on the Calendar day view.

= |n the Duration box, type or click the drop-down arrow and select from the list.
7. Selectthe Alarm check box to set an alarm to notify you before the activity begins. Type or select a length of time.
Verify that your name is in the Leader box.
In the Notes box, type Follow-up call for Joan Smith’s literature request.

10. Under Associations, verify the Associations list contains Joan Smith and Beeker Motors.

When you add an association, the activity appears on the Activities tab on the associated detail
view.

a. To add additional contacts, accounts, opportunities, quotes, sales orders, campaigns, leads, defects, returns,
or tickets, click the drop-down arrow, select the record type from the list, and then click the Add activity
association icon.

b. Use the Lookup to find the records you want to associate with the activity, and then click Add Selected.
c. Ifyou associate contacts or leads, you will be asked if you want to add the contacts or leads as attendees.
« To add associated contacts or leads to the Attendees tab, click Yes.
« Toleave the records as associations only, click No.
d. Repeat steps a-c for each record you want to associate.

11. Inthe Associations list you can hover over the record name to view limited detailed information. The details that
display depend on the record type. To hide these details, move the cursor to a different location in the view.

12. Click the Availability tab to make sure you are available at the selected Start Time and or to add resources or other
members.

You can only add members or resources to phone calls and meetings.

13. Click the Attendees tab to include additional contacts and leads.
14. Click OK.

You can view the scheduled phone call in the Contactand Account detail views (on the Activities tab), in the Activities view
(on the All Open and My Activities tabs), and in the Calendar view.

@ For more information see the "Scheduling or Editing an Activity" topic in the Infor CRM SLX Web Client
Help.
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Adding a Note

You use notes to document the outcome of an activity and to record interactions with an account, contact, lead, or
opportunity. The notes you add appear in the Notes/History tab on the detail views.

There are several ways to add a note. One method was chosen for the example below.

Our scenario:

You found Tom Dale’s business card while cleaning out your briefcase. You had a note on the back indicating Tom
was interested in a support contract for any products his company purchased. You want to add this information to Infor
CRM SLX.

To add a note

N o o s~ o=

10.
11.

12.

13.

14.
15.

Open Tom Dale’s Contact Detail view.

On the New menu, click Note.

In the Regarding box, type Business card notes.

In the Location box, type 2025 Trade Show.

In the Category box, click the drop-down arrow and select an item from the list.
In the Priority box, click the drop-down arrow and select an item from the list.

If necessary, modify the Completed and Scheduled dates. To modify the date, click the Calendar button to select
the date.

Leave Timeless selected since you do not need to enter a duration for the note.
Verify that your name is in the Leader box.
In the Notes box, type the information on the business card.

Under Associations, verify the Associations list contains Tom Dale and Beeker Motors.

When you add an association, the note appears on the Notes/History tab on the associated detail
view.

a. To add additional contacts, accounts, opportunities, quotes, sales orders, campaigns, leads, defects, returns,
or tickets, click the drop-down arrow, select the record type from the list, and then click the Add activity
association icon.

b. Use the Lookup to find the records you want to associate with the activity, and then click Add Selected.
c. Ifyou associate contacts or leads, you will be asked if you want to add the contacts or leads as attendees.
» Toadd associated contacts or leads to the Attendees tab, click Yes.
« Toleave the records as associations only, click No.
d. Repeat steps a-c for each record you want to associate.

Click the Follow-up drop-down arrow and select the follow-up activity type. Select To-Do.Schedule a follow-up
activity.

Use the Carry Over Notes or Carry Over Attachments check boxes to copy notes or attachments from this note to
the follow-up activity.

If necessary, click the Attachments tab to add a document or URL.
Click OK.
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16. Inthe Schedule To-Do dialog box, schedule an activity for today.
a. Forthe Regarding type Research.
b. Inthe Notes type, Research a support contract for Beeker Motors.
c. Click OK to schedule the activity.

You can view notes on the Notes/History tab of the Contact, Account, Lead, and Opportunity Detail views. In addition, the
Notes/History tab allows you to view and filter notes and other history items.

9 For more information see the "Adding a Note" topic in the Infor CRM SLX Web Client
Help.
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Chapter 3
Managing Your Sales Activities

Infor CRM SLX can help you manage your daily activities, whether they are scheduled or unscheduled. Scheduled activities
include phone calls, meetings, to-dos, and appointments. Unscheduled activities, such as returning a phone call or
answering e-mail, may occur several times a day.

In this chapter, you will learn to:
= Use Alerts
= Complete an unscheduled activity and schedule a meeting
®  Use the Calendar and Activities views

= View the history of an account

Using Activities and Events

Activities and Events provide a way to stay on top of your work responsibilities.
= Events usually span several days and might include trade shows, business trips and conferences.

= Activities include placing phone calls, attending meetings, and to do's, such as sending correspondence or preparing
presentations.

® Activities can be associated withother records such as contacts, accounts, leads, opportunities, tickets,quotes, sales
orders and others. Activities are generally scheduled for a specific time, but can also bescheduled as "timeless"
activities. Activities are generally scheduled for a specific time, but can also be scheduled as "timeless" activities.
Completed activities become history items.

®  You can schedule activities during an event, such as setting up various appointments and meetings for a business
trip.

When you schedule an activity, it displays on the Calendar, Activities view, and in the Activities tabs on the asociated detail
views. Activities are generally scheduled for a specific time, but can also bescheduled as "timeless" activities. Completed
activities become history items. The Infor CRM SLX Web Client includes an Alerts feature that alerts you to overdue
activities and new activities that you have yet to confirm.

Several activity types are available to accommodate your work requirements. For instance, you can create single
occurrence activities or recurring activities. In general, you can edit, delete, or complete activities and events that you create.

Using Alerts
Alerts help you keep track of activities with triggered alarms and unconfirmed activities. Your Alerts options determine how
you will be alerted for alarms and new unconfirmed activities.

You can snooze or dismiss selected activity alarms, or snooze or dismiss all of your alarms. You can also view Activity
details and accept or decline unconfirmed activities.
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To view Alerts

= |f the Alerts notification appears in your menu bar, click the drop-down arrow to display Alerts details.

""" If the Alerts notification does not appear in your menu bar, then either you have
no current alerts or your Alerts options may need to be changed.

To minimize Alerts

= |f you want to hide your active Alerts, click the drop-down arrow in the Alerts area of the menu bar.
The Alerts view will remain minimized until you click the drop-down arrow again or you receive a new alert.

Alerts - Alarms Tab

The Alarms tab in the Alerts view lists activities with active alarms. You can snooze or dismiss alarms or view, complete or
delete activities from the Alarms tab.

To snooze alarms
1. Select the check box for each activity alarm you want to snooze.
2. Selectatimeincrementin the Snooze by box, and then do one of the following:
= Click Snooze to snooze any selected activity alarms.

= Click Snooze All to snooze all of the activity alarms, even if they are not selected.

To dismiss alarms
= Do one of the following:
= Select the check box for each alarm you want to dismiss, and then click Dismiss.

B To dismiss all alarms, click Dismiss All.

To go to the activity detail view
= Click the activity type and regarding information that appears in blue text next to the activity icon.
Your Alerts are hidden and the activity detail view opens.
To view contact, account, or lead details

= Click the record name link.

To complete activities
1. Select the check box for each activity you want to complete.

2. Click the Complete selected activities button in the top part of the view.

To delete activities
1. Select the check box for each activity you want to delete.
2. Click the Delete Selected button in the top part of the view.
3. Click OK to confirm the deletions.
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Alerts - Unconfirmed Tab

An unconfirmed activity is an activity notification that you need to confirm or decline.

To view unconfirmed activity details

= Click the activity type and regarding information that appears in blue text next to the activity icon.
Your Alerts are hidden and the activity detail view opens.

To accept or decline an unconfirmed activity
1. Inthe grid, click the unconfirmed activity that you want to accept or decline.
2. Do one of the following:
= Click Accept to confirm that you will attend a phone call or meeting.

= Click Decline to confirm that you will not attend a phone call or meeting.

To go to the Calendar view

® Click the Show Calendar link at the bottom of the view.

To go to the Confirmations tab on the Activity view

= Click the Show Confirmations link at the bottom of the view.

Completing an Unscheduled Activity

Unscheduled activities can occur unexpectedly throughout the day. It is a good idea to keep Infor CRM SLX open at all times
so you can quickly access contact and account information. After you respond to an unscheduled activity, you should
complete the activity in Infor CRM SLX to create a record of the interaction with the contact or account.

When you complete an activity, details about it are recorded on the Notes/History tab for the related account, contact,
opportunity, or lead.

Our scenario:

You received an unexpected call from Tom Dale about a sales opportunity. You need to complete an activity for the
unscheduled phone call and schedule a follow-up meeting.

There are several ways to complete an activity in Infor CRM SLX. The following method allows you to complete the activity,
schedule a follow-up meeting, and carry over the notes.

To complete an unscheduled activity

Open Tom Dale’s Contact Detail view.

On the Schedule menu, select Complete an Activity.

Select the Create a New Unscheduled Activity to Complete option.

Select Phone Call, and then click Continue.

In the Regarding box, click the drop-down arrow and select Discuss Opportunities from the list.

o g  w b =

The Completed and Scheduled boxes automatically show the current date and time. You can accept the default, or
select a new date and time.

7. Inthe Notes box, type Tom Dale called about a possible sales opportunity.
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10.
11.

@

To schedule a follow-up activity
a. Click the Follow-up drop-down arrow and select Meeting.
b. Select Carry Over Notes to include your notes in the follow-up activity.
Click Now to complete the unscheduled activity.
In the Schedule Meeting dialog box, verify that the Notes field includes the notes from the phone call.

Select a date and time for the meeting, and then click OK to schedule the follow-up meeting

For more information see the "Completing an Activity" topic in the Infor CRM SLX
Web Client Help.

Inviting Others to a Meeting

When you schedule or edit a meeting or a phone call in the Infor CRM SLX Web Client, you can include other Infor CRM SLX
users in the activity. These types of appointments appear on the Confirmations tab in your Activities view. You can accept or
decline activities listed on the Confirmations tab. You may also receive an alert when you have an unconfirmed activity.

Our scenario:

You want to invite a co-worker (from your company) to your meeting with Tom Dale (a contact for Beeker Motors).

To invite others to a meeting

1.

@ a0 & w N

N

9.
10.

Open Tom Dale’s Contact Detail view.

Click the Activities tab.

In the list, open the meeting you scheduled in the previous scenario.
Click the Availability tab.

Click the Add Members and Resources button.

In the Add Members and Resources dialog box, use the lookup to find and select another Infor CRM SLX user, and
then click Add Selected.

Click the Add Members and Resources button again.

In the Add Members and Resources dialog box, use the lookup to find and select a resource, such as a conference
room, and then click Add Selected.

Use the Availability tab to make sure you, the other users, and the selected resource are available for the meeting.
Click OK.

The other user will receive an Alert to confirm the activity. After the user confirms or declines the meeting, you will receive a
confirmation of the response.

@

For more information see the "Scheduling or Editing an Activity " topic in the Infor
CRM SLX Web Client Help.
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Using the Calendar

Use the Calendar to manage your time and keep track of scheduled activities and events. The Infor CRM SLX Calendar
displays both open and completed activities and events, depending on your calendar options. You can view your schedule
by the day, week, or month view. Use the calendar right-click menu to schedule, edit, complete, or delete activities and

events.
Your calendar security determines whose activities you can schedule, view, edit, complete or delete.

Depending on your access rights, you can view the calendars and activities of other Infor CRM SLX users. Each user has an
assigned color to help identify which activities are for each user.

U Some icons may not appear in week and month views due to limited space.

Our scenario:

You want to check your calendar to see if you have time available to meet with your co-worker before the meeting with
Tom Dale.

To view the calendar
1. On the Navigation Bar, click Calendar.
2. Select the type of calendar to view.
= Day View - Displays a timeline for the day. Lists all scheduled activities and events for that day.

= Work Week View - Displays only the days in your work week as defined in your user options. Lists scheduled
activities and events for each day.

= Week View- Displays each day in the selected week. Lists scheduled activities and events for each day.
= Month View- Displays month calendar, listing scheduled activities for each day.

3. Each scheduled activity in the calendar is a link to the activity detail view. Double-click an activity to open the activity
details. Rest your mouse over the activity to view its details. Click a link togo to the associated recor's detail view.

4. To view another user's calendar, select the user's name from the Calendar Users list.

To manage the users in the Calendar Users list, click Edit Calendar Users.
The Edit Calendar Users screen opens.

a. Ifnecessary to filter the list, type the first couple of letters of a user's name in the Find User field and clickthe
Search button to search for a user. The calendar security determines whose calendars you can view.

b. Select the check boxes of the users you want to display in the Calendar Users list and clear the check boxes of
the users you want to hide. The name is selected by default and cannot be cleared. You can select up to 25
users in the list. However you can view up to four calendars at a time.

c. Click OK.
The Calendar Users list includes only the selected users.

e For more information see the "Using the Calendar" topic in the Infor CRM SLX Web
Client Help.
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Using the Activities View

Use the Activities view to manage your scheduled activities, events, literature requests, and confirmations. If you have
additional access rights, you can also view other Infor CRM SLX users' activities.

The tabs that appear in the Activities view are:

Alarms All Open Confirmations

My Activities Past Due Unconfirmed

You can also create your own groups.

The following icons provide information about the activity:

N L

Phone Call

Meeting

To-Do

Personal Activity

The activity is unconfirmed. (Not available on all tabs)
The activity has an attachment

The activity is a single occurrence of a recurring activity

D200 N8¢

The activity has an alarm

Our scenario:

You want to see how many phone calls you have tomorrow.

To view phone calls scheduled for tomorrow
1. On the Navigation Bar, click Activities.
2. Click the My Activities tab.
3. Use the Task Pane Filters to narrow the list:
=  Expand the Activity Type filter and select Phone Call.

= Expand the Time Frame filter and select Tomorrow.
All of the calls you have scheduled for tomorrow are shown in the tab.

4. (Optional) You can click the activity type to view its detailed information and make any required changes
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Using the History List View

Use the History List view to manage your history, including completed activities, notes, literature requests, reports, emails,
and database changes. If you have additional access rights, you can also view other Infor CRM SLX users' history.

You can use groups and filters to narrow the list of records in the list. For example, if the time frame is the current month, use
the Completed To Date filter to show only history items created this month to date.

The tabs that appear in the History List view are:

All History Completed Activities Database Changes
My Completed Activities My Notes

You can also create your own groups.

The following icons provide information about the history item:

Icon | Description

History item is a Database Change.

=
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History item is a mail merge Document.
History item is a sent email.

History item is a fulfilled Literature Request.
History item is a completed Meeting.

History item is a completed Phone Call.
History item is a Note.

History item is a completed Personal Activity.
History item is a Report.

History item is a completed To-Do.

History item has an attachment.

Our scenario:

You want to see the phone calls and meetings you have completed this month.

To view phone calls and meetings you have completed this month
1. On the Navigation Bar, click History.
2. Click the My Completed Activities tab.
3. Use the Task Pane Filters to narrow the list:
= Expand the History Type filter and select Meeting and Phone Call.

= Expand the Time Frame filter and select Month To Date.
Only the meetings and phone calls you completed this month are shown in the tab.

4. (Optional) You can click the history type to view its detailed information and make any required changes
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Viewing a History of Interactions with an Account

When responding to scheduled or unscheduled activities, you may need to view the history of interactions with the contact
and account or lead. For example, if a customer calls to ask a question she had from your last meeting, you can open the
account history to view the meeting notes. The Notes/History tab contains all interactions, including full text notes, and
provides filter options for viewing, e-mailing, and printing history items and notes.
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Our scenario:

You want to review all the interactions you have had with anyone at Beeker Motors.

To view account history

1

2
3.
4

Go to Beeker Motors’ Account Detail view.
Click the Notes/History tab. If the tab is not visible, click the More Tabs tab.
If necessary, click the Filter button and use the filters to narrow the list of history items.

Click the Type link of the history item you want to view.

For more information see the "Notes/History Tab" topic in the Infor CRM SLX Web
Client Help.
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Chapter 4
Communicating with Contacts and Leads

This chapter gets you acquainted with additional methods of sending information to your contacts or leads such as
proposals, letters, or memos by using the Infor CRM SLX Compose menu and Infor CRM SLX Mail Merge for Microsoft
Word add-in. You can create and edit templates, letters, and other business correspondence. You can then use Mail Merge
to merge your template with one or more leads, contacts or contacts related to one or more accounts, opportunities, sales
orders, quotes, contracts, returns, or tickets.

Outlook Integration with Infor CRM SLX enables you to share information between Microsoft Outlook and Infor CRM SLX
when you write e-mail messages, add contacts, and schedule meetings.

Outlook Integration features are now installed with Xbar. See "Understanding Infor CRM SLX Integration with
Microsoft Outlook" on page 24.

In this chapter, you will learn to:
= Create a template

= Use Mail Merge to send information to contacts

= Work with Microsoft Outlook e-mail

Working with Templates

You can use templates to create letters, proposals or e-mail messages that are used for more than one contact or lead.
Templates use standard text that does not change, as well as mail merge fields that use Infor CRM SLX information that
changes depending upon the contact or lead being merged.

Infor CRM SLX Word Templates and Web Email Templates

When you install the Infor CRM SLX Mail Merge for Microsoft Word add-in, you can create, edit, or manage Infor CRM SLX
mail merge Word templates from the Microsoft Word Mailings tab. To access these features, Microsoft Word must already
be installed and configured and users must install the Infor CRM SLX Mail Merge for Microsoft Word on page 22. For more
information see," Working with Word Templates" in the Web Client help.

In the Web Client you can select an existing template and perform a mail merge with the output to file or email. The
templates used for output to email are created and managed in the Web Client while templates used for output to file can be
created, edited, and managed in Microsoft Word. For more information see, "Working with Web Email Templates" in the
Web Client help.

Mail Merge and template management are not available for all the users.
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Using the Mail Merge Word add-in

After you install the Infor CRM SLX Mail Merge for Microsoft Word add-in, in Microsoft Word from the Mailings tab, you can
create, edit, or manage Infor CRM SLX mail merge Word templates and perform a mail merge to any Infor CRM SLX
template managed in Word with the output to file, printer, or email.

To access these features, Microsoft Word must already be installed and configured
and users must also install and configure the Infor CRM Mail Merge for Microsoft Word
add-in. For more information, see "Understanding Infor CRM SLX Mail Merge for
Microsoft Word" on page 22.

For more information about the Infor CRM SLX Mail Merge for Microsoft Word add-in,
see the Infor CRM SLX Web Client help topic " Infor CRM SLX Mail Merge for
Microsoft Word add-in" and the help topics available from help buttons on the Infor
CRM SLX Mail Merge for Microsoft Word add-in views.

Creating a New Template in Microsoft Word

These instructions help you create a new private Microsoft Word template.

Our scenario:

Tom Dale requested a pricing proposal for 150 motors. You need to create a new pricing proposal template.

To create a new template

1. In Microsoft Word, open a blank document that you want to save as a new template, on the Mailings tab, click Save
as New Template.

2. Inthe Template Properties dialog box, do the following:

a
b.

134

f.

In the Name field, specify Pricing Proposal.

In the Family field, select My Templates.

In the Main Table, select Contact.

In the Owner field, make sure your name is the owner.

In the Email Subject, type the default subject you want to use if this template is sent as an email message. For
this example, <Your company's> Pricing Proposal.

Click OK.

In the empty document, type the text you want to include in the proposal template.

To add Infor CRM SLX merge fields to the template, place the cursor in the template where you want the merge field
to appear, click Insert Field, then from the merge field list, select a field.
The new merge field appears in the template.

48 | Getting Started with the Infor CRM Web Client



Chapter 4 Communicating with Contacts and Leads

Performing a Mail Merge in Microsoft Word

These instructions help you create the merged document from your new template.

To create the proposal for Tom Dale

1.

-

12.

13.

14.

15.
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On the Mailings tab, click Compose Mail Merge.

If necessary, click the Template ellipsis button, expand Private Templates, expand My Templates, select Pricing
Proposal, and then click OK.

Select the Select Record option, select Contact from the drop-down list, and then click the ellipsis button.
In the lookup search for Tom Dale, select the record in the list and then click OK.

Clear the Enforce "Do Not Solicit" option as Tom Dale requested this information.

Select the Attach document to each record option.

Click the Select Address drop-down arrow and select Mailing.

Click the Output Type drop-down arrow and select File.

Click the Directory ellipsis button and browse to the location where you want the merged file to be saved.
Click the File format drop-down arrow and select PDF.

Click the History Options tab and select the Create history for each contact or lead and Add merged text to
the history notes options.

a. Forthe Result, select Complete.
b. Forthe Regarding, select Send proposal.
c. Inthe Notes box type Pricing proposal for 150 motors.
Click the Follow-Up Options tab.
a. Selectthe Schedule a Follow-Up option and select Meeting from the drop-down list.
b. Select Carry Over Notes box to carry over your notes from the history item to the follow-up activity.

c. Make sure the Timeless option is cleared and select a Start Time of next Monday at 9:00AM, click the
Duration drop-down arrow and select 1 hour.

d. Click the Reminder drop-down arrow and select 30 minutes.
e. Make sure the Leader is set to you.
f. Click the Category drop-down arrow and select Follow-up.
Click Merge to start the merge.
The Mail Merge In Progress dialog box shows the progress of the merge.
When finished, click OK to close the dialog box.
Windows Explorer opens to the Directory specified in step 14 with the merged document selected.

Double-click the merged document to open and view the pricing proposal.
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Using Mail Merge in the Web Client

You can use Mail Merge in the Web Client when you need to correspond with a group of contacts or leads. Mail Merge helps
you simplify the process of sending the same information to numerous people by merging information into a template. You
can perform a mail merge output to file or email.

Each output type supports a different type of template:

= Qutput to file uses Word-based templates that are also used in Infor CRM SLX Mail Merge for Microsoft Word. See

the Web Client help topic "Working with Word Templates". Selecting a Word email template saves the file locally. Itis
not possible to email a Word template from the Web Client.

Output to email uses email templates that are created and managed in the Web Client. See the Web Client help topic
"Working with Web Email Templates". Performing an email mail merge with a Word template is only supported in
Microsoft Word.

For more information see the Web Client help topic "Using Mail Merge in the Web Client".

Creating a New Email Template in the Web Client

These instructions help you create a new Email template.

Our scenario:

You need to create a email template to thank customers for allowing you to demonstrate your product.

To create a new email template

1.

On the Compose menu, click New Email Template.
The Insert Email Template page is displayed.

In the Name box type Thank You - Demo.
This is the name of the template that displays when selecting an email template.

In the Description box type Thank you email after demo.
This is a brief description of the email template content or suggested use.

Click the Contact/Lead drop-down arrow and select Contact.
The properties available for contact templates are different than the properties available for leads, therefore it is
important to have separate templates designated for contacts and leads.

Click Save.

In the Email Template detail view, click in the Body section, you can type and format text and add SLXfields using
the @mention user interface.

For this example, type:

Dear @PreferredName,

Thank you so much for allowing us to present a solution to @Contact.Account. We feel that, together with your team,
we have identified @Contact.Account's PC needs and recommended a package that will provide great performance
and reliability for your staff.

Please let us know if you have any outstanding questions at all. We are working on your proposal and will have that to
you shortly.

Thank you again for your time!

@Username

@Title

@UserCompany

@Userinfo.Phone
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Mail Merge to Email in the Web Client

These instructions help you create a new Email template.

Our scenario:

You recently provided a demonstration for upgrading all of your contacts at Beeker Motors, and want to send an email
letter thanking them for their time. You want to run a mail merge to send the information to all contacts at once..

To send an e-mail using Mail Merge

1. Onthe Compose menu, click Mail Merge.
The Mail Merge dialog box is displayed.

On the Merge With tab, click the Entity Type drop-down arrow, select Account, and the click the Lookup icon.
In the Lookup, specify Be, click Search, and then double-click Beeker Motors in the list.

Click the Output Type drop-down arrow and select Email.

Click the Template button, and begin typing Thank you.

Select Thank you - Demo from the list and click OK.

Leave the Primary contact only and Enforce "Do not solicit" options selected.

Select the Attach document to each record option.

Click in the Subject box and type Thank You.

© © ® N o gk~ oD
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Select the Send emails to the contact/lead email address option to use the email addresses defined for each
contact in Infor CRM SLX. Selecting this option makes the Recipients box unavailable.

[N
[N

In the CC box, type @ and then type the name of an Infor CRM SLX user, team, or department to send the email to
additional people in your organization. Or type the email address of someone who is not an Infor CRM SLX user,
contact, or lead.

12. Click the History Options tab.

13. Make sure the Create history record for each contact or lead option is selected.

14. Click the Regarding drop-down arrow and select Send e-mail message.

15. Click the Follow-Up Options tab.

16. Select the Schedule a Follow-Up option, click the drop-down arrow and select Phone Call.

17. Clear the Schedule separate follow-up activity for each contact option, as you want to schedule a single phone
call with all contacts as attendees.

18. Select a Start Time of next Thursday at 10:00AM, click the Duration drop-down arrow and select 1 hour.
19. Click the Reminder drop-down arrow and select 30 minutes.

20. Make sure the Leader is set to you.

21. Click the Category drop-down arrow and select Follow-up.

22. Click OK.

The merged emails are sent to all recipients and history records are added for each contacts. For more information
see the "Using Mail Merge in the Web Client" topic in the Infor CRM SLX Web Client Help.
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Outlook Integration

Outlook Integration features are now installed with Infor CRM Xbar for Microsoft
Outlook.

If your company uses Outlook Integration, you can save Outlook e-mail messages as Infor CRM SLX history items. For
example, you can:

Compose an e-mail message in Outlook, select contacts from the Infor CRM SLX Address Book, and then click Send
to CRM to record the e-mail body and any attachments to the associated record. You can also include attachments to
the message.

Select an e-mail message in Outlook, and then click Record to History to record the e-mail body and any attachments
to the associated record.

Send an Infor CRM SLX contact's information in a vCard file format via e-mail.
Attach documents from Infor CRM SLX Library to a message in Outlook.
Drag and drop e-mail messages from Outlook to the Infor CRM SLX History tab.

Click the E-mail button on the Contact or Lead Detail view to open a new e-mail message addressed to that lead or
contact.

Click the E-mail button on the Ticket Detail view to copy ticket information into a new e-mail message, and then click
Send to CRM in Microsoft Outlook to send the message and save it to Infor CRM SLX.

e For more information see the following topics in the Infor CRM SLX Web Client Help:

= "E-mailing a Contact or Lead"
= "E-mailing a Contact"
® "Installing and Using Infor CRM SLX Desktop Integration”

® "Sending an E-mail Message from a Ticket"

Sending email to multiple records using Outlook Integration

Our scenario:

You want to send an e-mail to Tom Dale and Joan Smith of Beeker Motors to tell them that you will be out of the office
for a few days. You can use Microsoft Outlook and record the e-mail message in Infor CRM SLX.

To send an e-mail to multiple records using Outlook Integration

1.
2.

On the Navigation Bar, click Contacts.
Use the Lookup to find the contacts you want to e-mail.
a. Click the Lookup tab (magnifying glass).

b. Inthe first box select Account, in the second box select Starting With, in the third box type Be, and then click
Search.

Select Tom Dale and Joan Smith.
To select more than one record, hold down [Ctrl] or [Shift], and highlight the records.

From the Task Pane, under Common Tasks, select E-mail.

If the Select Names dialog box opens, select both names and click the To button, and then click OK.
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If e-mail is enabled, but you have not logged on, at the message box, click Yes to log on.
In the Subject line, type Out of Office.

In the Body area, type | will be out of the office for a few days. I'll contact you when | return.
Since you are using Outlook to send this e-mail message, you may want to record this to Infor CRM SLX History.

Click the Send to CRM button.
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Chapter 5
Managing Opportunities for Sales

Opportunities are potential sales to accounts and contacts. As an opportunity progresses, you can track the products
involved in the opportunity, days in the pipeline, competitors, level of commitment by the prospect, and much more.

In this chapter, you will learn to:
= Add an opportunity
= Use Opportunity Statistics

= Close an opportunity

Adding a New Opportunity

Use the Insert Opportunity view to enter opportunity information and to add competitors or contacts. You can also update the
opportunity currency and rate if you have Multi-Currency enabled.

e If you frequently use the same settings when adding opportunities, you can set default
values.To set the default values for opportunities, go to Tools > Options and select
the Opportunities tab. For more information see the "Setting Opportunity Options"
topic in the Infor CRM SLX Web Client Help.

Itis not necessary to complete all information when you add an opportunity. You can add the information that is most
important to your company when you add the opportunity, and then update the Opportunity Detail view with more information
later. For example, when you add an opportunity, you may want to note the probability of closing the sale, the dollar amount,
and the estimated close date. Then add information as the opportunity moves through the pipeline.

® You can add products to the opportunity after it is created using the Products tab in the Opportunity Detail view.

= Adding contacts to an opportunity allows you to target the individuals at the account and designate their roles and
influence in the possible sale. If you do not add contacts while adding the new opportunity, you can add them later
using the Contacts tab in the Opportunity Detail view.

Our scenario:

There is an opportunity for a sale of 10 printers to Beeker Motors. You want to create a new opportunity and add
contacts and products.

To add a new opportunity
1. Open the Beeker Motors' Account Detail view.

2. Onthe New menu, click Opportunity.

3. Complete the following information:
Based on your Opportunities options, some boxes may already be completed.
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= Description - Enter a name for the opportunity.
To help track opportunities, use the account name in the opportunity description.

= Account - Verify the account is Beeker Motors.

= Account Manager - Click the Find button to find the person or team within your organization who manages the
account.

= Add To Forecast - Select if you want to include the opportunity in forecast calculations or clear the checkbox to
exclude it from forecasts.

= Type - Click the drop-down arrow, and select New.
= | ead Source - Click the drop-down arrow and and select Trade Show - General.

= Status - Your company defines the opportunity status list. Click the drop-down arrow, and select a status from
the list.

= Estimated Close - Click the Calendar button, select the date that the opportunity is estimated to close, and
then click OK.

= Close Probability - Click the drop-down arrow, and then select the probability that this opportunity will be
closed from the list.

4. Add the opportunity contacts.
a. Inthe Contacts section, click the Include Contact button.

b. From the lookup, select Joan Smith and Tom Dale, click Add Selected, and then click Close.From the
lookup, select Joan Smith and Tom Dale, click Add Selected, and then click Close

5. Click Save.
The opportunity detail view of the newly added opportunity opens.

6. Add the opportunity products.
a. On the Opportunity detail view, click the Products tab and click the Include Product button.
b. From the lookup, select NetPrinter Laser Elite, click Add Selected, and then click Close.

c. Inthe grid, click the Quantity column and change 1 to 10.

Using Opportunity Statistics

You can use Opportunity Statistics to view opportunity information at a glance. You can view opportunity statistics for a group
of opportunities, or you can select individual opportunities from the Opportunity List view.

To open Opportunity Statistics
1. On the Navigation Bar, click the Opportunities button.

2. Inthe Opportunities List view, open the group of opportunities you want to view.
You can open the opportunity group using the Opportunity Group list.

3. Select the records you want to view, and do one of the following:

If you do not select any records the statistics will be based on all records in the
group. If prompted click Yes to view statistics based on all records in the group,
click No to cancel.

= Right-click and select Opportunity Statistics.

® |n the Task Pane, under Common Tasks, click Opportunity Statistics. If prompted,

4. When finished, click Close.
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Closing an Opportunity

When an opportunity is won or lost, you should close the opportunity. For future reference and reporting purposes, you
should provide the reason for closing the opportunity.

Our scenario:

Beeker Motors has agreed to your terms and pricing and now you may close the opportunity.

To close an opportunity

1.
2.

Open the Beeker Motor's opportunity in the Opportunity Detail view.

In the Status box, click the drop-down arrow, and select Closed-Won from the list.
The Close Opportunity dialog box opens.

In the Actual Amount box, verify the amount of the sale is listed.

If necessary, modify the Actual Close date. To modify the date, click the Calendar button, select a new date, and
then click OK.

In the Reason Won box, click the ellipsis button, select an item or items from the list, and then click OK.

In the Comments box, type Delivery must be complete by the end of the financial quarter.

Click OK.
Beeker Motors’ Opportunity Detail view appears with a Closed-Won Status and the Probability automatically updates
to 100%.

Assigning a Serial Number to an Asset

To add an asset to an account

1.
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Click the Beeker Motors link.

Click the Assets tab. If the tab is not visible, click the More Tabs tab.

Click the Add Asset button.

In the Add Asset dialog box, click the Name Find button.

From the lookup, search for and select NetPrinter Laser Elite, and then click OK.
In the Quantity box, type 10.

In the Serial Number box, type BMNPLEO0O1.

Click OK.
The asset appears in the product list for that account.
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Chapter 6
Managing Leads and Campaigns

This chapter is an introduction to Infor CRM SLX Marketing. With Infor CRM SLX Marketing you can develop and qualify new
sales leads, convert leads in into customer in a structures process, and create and manage sales campaigns while tracking
their effectiveness.

In this chapter, you will learn to:
= Add leads to Infor CRM SLX
= |mport leads to Infor CRM SLX
= Qualify alead
= Add a campaign
= Add targets to a campaign
= Add stages and tasks to a campaign
= Add products to a campaign
® | aunch a campaign

= Track campaign responses

Working with Leads

Leads are unqualified potential customers. Use lead qualification criteria to determine if a lead has valid information, already
exists as a lead or contact, or is ready to be converted to a sales opportunity. Once qualified, a lead can be converted to or
merged with a contact and account. You can also create a new sales opportunity.

Adding a Lead

There are many ways in which your company can acquire leads. They may buy lead lists, acquire another company’s
customers, or find a single lead while maintaining current accounts. If you have multiple leads, importing the information to
Infor CRM SLX is the most efficient method. However, if you cannot import lead information, you must manually add the lead
(s) to Infor CRM SLX.

Our scenario:

While you were speaking to a current contact, he mentioned his friend Bob Green may be interested in purchasing
some software. You need to add Bob Green to Infor CRM SLX as an unqualified lead.
To add
1. Onthe New menu, click Lead.

2. Inthe Name box, type Bob Green.
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10.
11.
12.

In the E-mail box, type bob.green@greendentist.mail.
In the Company box, type Green Dentistry.
In the Phone box, type 5553211234.

Click Look for Matching Records to search the database for leads, contacts and accounts that have matching
information.

The Matching Leads dialog box appears. If a matching record displays in this dialog box, you can open the matching
record to see if the lead, contact, or account is the same as the lead you are entering.

In the Matching Leads dialog box, no matches were found so click Cancel.

In the Title box, select or type Managing Director.

Click the Lead Source drop-down arrow and select Word of Mouth/Referral.

In the Industry box, click the drop-down arrow, select Healthcare/Medical/Pharmaceutical, and then click OK.
In the Interested In box, type accounting software.

Click Save.

Importing Leads

Your company may purchase mailing lists or have a large number of potential customers that must be tracked in Infor CRM
SLX. Rather than adding leads one at a time, you can import large numbers of leads to Infor CRM SLX quickly and easily.

Use the Import Leads view to import lists of leads into Infor CRM SLX. You may only import leads from a comma-separated-
values (CSV) list. Valid file types include Microsoft Excel, .txt files, and other database file types, but files must be saved as a
CSVfile.

Our scenario:

Your manager has given you a file containing 200 leads. You want to import the leads into Infor CRM SLX so that you
can begin calling them.

To import leads

1.
2.

From the Tools menu, click Import Leads.

Next to the Select a file containing Leads information to start box, click Browse, browse to the list you want to
import, and then click Open.

Click the Default Owner Find button to select the person or team within your organization that will own the imported
leads.

Click the Default Lead Source Find button and select Purchased List - General.
Make sure Create a new ad hoc group is selected.

Click Next.
The wizard moves to Step 2, Define Delimiter.

Preview the records before they are imported. If necessary, select a different delimiter value, for example a comma,
semicolon, or text qualifier.

e For more information see the “Defining a Delimiter” topic in the Infor CRM SLX
Web Client Help.
Click Next.

Match the lead list fields and Infor CRM SLX lead fields. If you want to display all of the fields in both lists and any
template, select Show All Fields.
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10.
11.

12.

13.

14.

15.

16.

17.

a. Select the external list field and Infor CRM SLX field to be matched.

b. Click Match.
Matched Infor CRM SLX fields display in the Matched Infor CRM SLX Field column.

Repeat the previous step for each field that needs to be matched.

Click Next.
The wizard moves to Step 4, Manage Duplicates.

Complete the Manage Duplicates information.
a. Select Check for duplicate leads.
b. Nextto Type, select Contact and Lead make sure records do not already exist as a contact or lead.

c. Under Match Filters, select the filter check boxes that you want to apply. For example, First Name, Last Name,
Work Phone, E-mail, Account/Company.

d. For this scenario, clear the Auto-merge duplicate records option.

@ For more information see the “Rules for Automatically Merging Records
During Import” topic in the Infor CRM SLX Web Client Help.

e. Ifyou want to check for duplicate records within the import source file, select the Check for duplicates
contained within the import source file option.

f. Click Run the Test to run the Find Duplicates Test on the first 100 records in the import or all of the records if
you selected the previous option.

@ For more information see the “Managing Duplicate Records” topic in the
Infor CRM SLX Web Client Help.

Click Next.
The wizard moves to Step 5, Select Import Actions.

Complete the Select Import Actions information.
Use import actions to specify actions to be performed for the leads you import to Infor CRM SLX.

a. Nexttothe Add Note action, click Define.
b. Inthe Add Note dialog, select Timeless, and in the Notes box type This record was imported from a list.

c. Click Save.

@ For more information see the “Selecting Import Group Actions” topic in the
Infor CRM SLX Web Client Help.

Click Next.
The wizard moves to Step 6, Review.

Review the import selections and click Submit.
The wizard moves to Step 7, Process Request.

When the import is finished, click the Import Number link to see the import history results in the Import History view.
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Qualifying a Lead

A lead may contain unqualified information. You can use lead qualification criteria to validate information and determine if the
lead is a sales opportunity. Once qualified, you can convert a lead to a contact and account and create a new sales
opportunity.

Our scenario:

You spoke to Bob Green on the phone and he has decided to order from your company. You need to add the
information regarding Bob’s purchase and convert him to a qualified lead.

U If your Qualification criteria was customized by your administrator, the items you see
in your workspace may be different.

To qualify a lead

1. Click the Leads button on the Navigation bar.

2. Click the Lookup tab (magnifying glass).

3. Use the Lead lookup dialog box to find Bob Green:
a. Inthe Lookup by box, select Name.
b. Inthe next box, select Starting with.
c. Inthe third box, type green, and then click Search.

4. Inthe list, click Green, Bob.

5. Inthe Qualification box, click the drop-down arrow, and then click Lead.

6. Under Qualification:
a. Selectthe Valid Contact check box.
b. Select the Budget for purchase check box, and then in the corresponding text box type 15000.
c. Selectthe Timeframe for purchase check box, and then in the corresponding text box type 3 months.

d. Select the Business need identified check box, and then in the corresponding text box type accounting
software.

e. Selectthe Decision maker identified check box, and then in the corresponding text box type Bob Green.
7. Once the lead is qualified and ready to convert to a contact and account, click the Convert Qualified Lead button.
8. Inthe Convert Lead dialog box, verify that no existing contacts or accounts match the lead you are qualifying.
9. Click Convert.
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Working with Campaigns

A campaign is a combination of various advertising, public relations, sales promotion, and selling activities used over a
period of time to achieve predetermined sales or marketing goals. A campaign can target a specific industry or group. Infor
CRM SLX Marketing allows you to track information such as the time frame of the campaign, products associated with the
campaign, response rates for a campaign, and more.

Adding a Campaign

After you have determined what type of campaign your company plans to use, you can add the information to Infor CRM
SLX.

Our scenario:

Your company has decided to run a return mail advertisement campaign to all leads and contacts in the state of lllinois.
You need to add the campaign information to Infor CRM SLX. This includes the campaign targets, stages, and tasks
that must be completed during the campaign.

To add a campaign

1. Onthe New menu, click Campaign.
The Insert Campaign dialog box appears.

2. Inthe Campaign Name box, type IL Return Mail Ad Q4 FY2025.

In the Description box, type Return mail advertisement for IL - Fall 2025.

4. Inthe Objective box, type Promote PC v7.
In this scenario, the objective of the campaign is to promote the new version of Pocket PC.
5. Inthe Call to Action box, type Pre-register and save 10%.
6. Inthe Lead Sources box, click the Find button, and next to Advertising - General, click Associate.
7. Inthe Status box, select Setup.
8. Inthe Code box, type RMAdQ42025.

The code is a unique identifier for this campaign.
9. In the Start Date box, type or select next Monday’s date.
10. Inthe End Date box, select a date 3 months in the future.
11. Inthe Manager box, click the Find button, select your name, and then click OK.
12. Leave the Owner as Everyone.

13. Click Save.

Adding Targets to a Campaign

When you identify your targets, you isolate the contacts, accounts, and/or leads on which to focus your marketing efforts.
Effectively targeting your audience allows you to make the most of your marketing campaign by spending time and money
on a segment of the market most likely to purchase from your company.

To add targets to a campaign
1. On the Navigation Bar, click Campaigns.
2. Open the IL Return Mail Ad Q1 FY2025 campaign in the Campaign Detail view.
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Click the Targets tab.
Click the Add Targets icon.
Use the filters to narrow the list of records.
a. Select Accounts (all Contacts).
b. Select the State check box, select Starting with in the drop-down box, and then type IL in the text box.
To find out how many targets meet the filter criteria before searching, click the How Many? button.
Click Search.

Click the Add Targets button to add all the targets in the list and close the dialog box.
The targets appear in the Targets tab grid.

Adding Campaign Stages and Tasks

To add a stage to a campaign

N

8.

Open the IL Return Mail Ad Q4 FY2025 campaign in the Campaign Detail view.

From the Campaign Detail view, select the Stages/Tasks tab, and then click Add Stage'l' .
In the Description box, type Prepare ad slick.
In the Status box, click the drop-down arrow, and select In Progress.

In the Comments box, type Used in-house ad department. Updated campaign previously targeted to state of
CA.

In the Start Date box, select today’s date.
In the End Date box, select a date one week from today.
Click OK.

Campaign tasks can help Infor CRM SLX Marketing users manage their campaigns. You can add and edit task information,
or complete a task once it is finished.

To add tasks to a campaign

-

In the Campaign Detail view, on the Stages/Tasks tab, click Add Task next to the appropriate campaign stage.
In the Description box, type Update CA ad slick from FY2011 Q4 campaign.
In the Status box, click the drop-down arrow and select Completed.

In the Priority box, click the drop-down arrow and select an item from the list.

In the % Complete box, type 100.

In the Needed Date box, select yesterday's date.

In the Assign to section, select Other Individual.

In the Assign To box, type Advertising Dept - Tom.

Click OK.

To add another task, click Add Task next to the campaign.

In the Description box, type Print new ad slick.

In the Status box, click the drop-down arrow, and then select In Progress.

In the Needed Date, select a date 6 days from today.
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14. Inthe Assign to section, select Other Individual.
15. Inthe Assign To box, type Print Vendor.
16. Click OK.

Adding Products to a Campaign

Products are the goods and/or services that you are selling in a campaign. You can add products to a campaign when you
add the campaign information to Infor CRM SLX, or you can add or change product information for an existing campaign.

Our scenario:

Management wants to add an incentive to the campaign. You need to add additional products to the direct mail
campaign.
To add products to an existing campaign
1. Open the IL Return Mail Ad Q4 FY2025 campaign in the Campaign Detail view.
2. Click the Products tab. If the tab is not visible, click the More Tabs tab.
3. Click the Associate Products button.
4. Select GoStore 200GB and Kiva Big Mouth Briefcase, and then click Add Selected.

Launching a Campaign
When all campaign information has been added to Infor CRM SLX, you are ready to launch the campaign. Launching the
campaign allows Infor CRM SLX to begin tracking information used in reports, budgets, and so on.

When a campaign is launched, the campaign target contacts and leads are assigned to the first stage of a campaign and
their status is changed to "Launched".

Our scenario:

After verifying all the campaign steps and information, you want to launch the campaign.

To launch a campaign
1. Openthe IL Return Mail Ad Q4 FY2025 campaign in the Campaign Detail view.
2. Verify all the information is correct.
3. Click Launch.
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Tracking Campaign Responses

After you launch a campaign, you can begin to track the responses associated with the campaign. Campaign responses
include who responded, the date, the response method, any notes, and so on. You can track responses during various
stages of the campaign. Adding this information correctly helps your company to identify successful campaigns and stages
to aid in refining and running successful campaigns in the future.

Campaign responses can be added and viewed in the Infor CRM SLX Web Client Client.

Our scenario:

You need to add a response for a recent campaign. The individual has decided to purchase from your company.

To add and view campaign responses

1.

Ll
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Open the IL Return Mail Ad Q4 FY2025 campaign in the Campaign Detail view.
Click the Responses tab.
Click the Add Campaign Response button.

Select Contact, click the Contact Find button, type st, click the Search button, select the first name in the list, and
then click OK.

Click the Response Method drop-down arrow and select Phone.

In the Comments box, type Responded within 5 days. Qualifies for 10% discount and free carrying case.
In the Products section, click Add Product, click Search, select Kiva Big Mouth Briefcase, and then click OK.
Click OK.
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Chapter 7
Working with Customer Service and Support

This chapter introduces you to the Infor CRM SLX Customer Service and Support features. The Customer Service and
Support features allow designated users to track, qualify, and resolve customer questions and issues.

In this chapter, you will learn how to:
= Understand and work with contracts
= Add, work in, and close tickets
®  Add and close areturn

= Add and close a defect

Working with Contracts

Contracts are agreements between accounts and your company to provide support for products sold. Infor CRM SLX has
five general types of contracts that cover support services. In addition, a contract can cover a specific set of products, or it
can be a “blanket” contract that covers all products the account owns. You can use contracts to verify that support should be
provided to specific accounts for specific products.

Understanding Contract Types

The five default contract types are:

Type Description

Days The contract is tracked according to a number of days of services the account has purchased.
This value is entered into the Quantity box for the contract. When the contract type is Days, and
as activities are generated for the account, the value in the Remaining box will not decrement.

Hours The contract is tracked according to a number of hours of services the account has purchased.
This value is entered in the Quantity box for the contract. The total time is calculated using the
Elapsed Hours value for all activities generated for the account. As activities are generated, the
value in the Remaining box decreases to reflect the number of hours left on the contract

Incidents The contract is tracked according to the number of service calls the account has purchased. This
value is entered into the Quantity box for the contract. The total number of incidents reflects the
total number of tickets the account has opened. As tickets are opened, the value in the
Remaining box decreases to reflect the number of incidents left on the contract.
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Type Description

Value

Perpetual

The contract is tracked according to a currency value placed on the services the account has
purchased. This value is entered into the List Price or Contract Amount box for the contract.
When a ticket activity is created against the contract, the activity's Total value is charged against
the contract amount, and the value in the Remaining box decreases to reflect the value left on
the contract.

The contract has no limit. The account can open an unlimited number of tickets and activities for
an unlimited amount of time.

To ensure that the time, number of incidents, or currency value left on a contract is tracked accurately, you must activate the
contract before beginning work on a ticket.

Adding a Contract

Each contract you add must be connected with an account that already exists in Infor CRM SLX. The following scenario
explains how to create a contract for an account.

Our scenario:

Tom Dale calls to request a new contract. He wants a one year contract that covers up to 10 incidents.

To add a contract

1. Open the Beeker Motors Account Detail view and select the Contracts tab. If the tab is not visible, click the More
Tabs tab.

2. Click the Create Contract button.

3. Complete the contract information boxes.

a.
b.
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m.

In the Reference #, type a reference number for the contract.

Verify that Dale, Tom is listed in the Contact box. If not, click the Find button and select Tom Dale from the
lookup.

Select Active.

In the Comments box, type New 1 year contract for 10 incidents. Qualifies for new customer discount.
Click the Service drop-down arrow and select Classic Care Ultra from the list.

Click the Contract Type drop-down arrow and select Incidents from the list.

Leave the Start Date as today's date.

Type a purchase order number in the PO Number box.

In the Purchase Date box, select today's date.

In the List Price, type 500.00.

In the Discount box, type 50.00 because he qualifies for a new customer discount.
The Contract Amount is automatically calculated

Click the Expiration Calendar button and select the date one year from today.

In the Quantity box, type 10. This specifies that the contract covers 10 incidents in the next year.

4. Click Save.

5. Associate Beeker Motors assets to the contract.

a.
b.

C.

On the Contract detail view, click the Covered Assets tab. If the tab is not visible, click the More Tabs tab.
Click the Associate Asset button.

In the lookup select NetPrinter Laser Elite, and then click Add Selected.
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Working with Tickets

Tickets are records of customer inquiries or complaints. They can contain the information necessary to report, investigate,
and close an inquiry or problem. Before you add a ticket, the account and contact must exist in Infor CRM SLX.

Adding a Ticket

Our scenario:

Tom Dale at Beeker Motors called. He is having a problem with one of their printers and needs the problem resolved by
the end of the week. You need to create a ticket to work on the problem.
To add a ticket
1. Open Tom Dale’s Contact Detail view.
2. Onthe New menu, click Ticket.
3. Inthe Insert Ticket view, verify Beeker Motors appears in the Account Name box.
4. If necessary, in the Contact Name box, click the Find button, and then select Tom Dale.
5

In the Contract box, click the Find button, use the Lookup Contract to select the contract you created in the
previous scenario, and then click OK.

o

In the Source box, click the drop-down arrow, and then select Phone.

7. Inthe Area box, click the Find button and in the Area list select Hardware.
Options available for Hardware appear in the Category list.

8. Inthe Category list, select Printer.
9. Inthelssue list, select Power, and then click OK.
10. Inthe Status box, click the drop-down arrow, and then select In Process.
11. Click the Urgency drop-down arrow, and then select Med-High.
12. Inthe Needed Date box, use the Calendar button to select a date at the end of the week.
13. Verify the Assigned To box lists your name. If necessary, click the Find button and select your name from the list.
14. Inthe Subject box, type a short summary of the problem.

15. Inthe Description box, click the Add problem timestamp button, and then type detailed information for the
problem.

16. Under Comments, in the Internal box, click the User Date Stamp button, and then type additional information that
is important to the ticket.

17. Click Save.

Adding Ticket Activities

Ticket Activities are added through the Ticket Activities tab on the Ticket Detail view. Ticket Activities enable you to track the
time, the types of tasks, and any associated costs involved in resolving a ticket. Activities are recorded by activity type and
charge rate and are used for billing the customer against their service contracts. You can add your own ticket activities at any
time from the Ticket Activities tab.
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Our scenario:

You told Tom Dale that you will research his problem and call him back. You need to add a ticket activity for the
research time.

To add a ticket activity

1.
2.
3.

11.

12.
13.

Open Tom Dale's ticket.
Click the Ticket Activities tab. If the tab is not visible, click the More Tabs tab.

On the Ticket Activities tab, click Advanced.
The Insert Ticket Activity view opens.

In the Public Access box, click the drop-down arrow and select 1-Customer.
This setting determines whether customers will be able to see the ticket activity using Infor CRM Customer Portal.

Select the Follow Up option if the ticket activity requires further action. If this check box is selected, the ticket is
added to the Follow-Up group in the Ticket List view.

In the Type box, click the drop-down arrow, and then select Research.

Verify that the Start Date box displays the correct start date and time for the activity. If not, click the Calendar button
to specify the correct date and time.

Since you have not yet completed the activity, skip the End Date box. When you complete the activity, you will use
the Calendar button to select the date and time you finished working on the activity.

Itis very important that you select accurate dates and times in both the Start Date and End Date boxes because this
information is used to calculate the Time Units, Elapsed Hours, Rate, and Total Labor.

Click the Due Date Calendar button to specify the correct date and time.

Verify that the User box displays your name. If not, click the Find button to locate your name or the name of the
individual who will be responsible for completing the activity.

(If necessary) In the Charge Type box, click the Find button, select No Charge,and then click OK.
The charge type is the rate your company charges against the customer’s support contract for the work you
performed.

In the Comments box, type Research printer power issues.
Click Save

9 For more information see the "Adding and Editing Ticket Activities" topic in the Infor CRM SLX Web

Client Help.
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Punching In and Out of a Ticket

The Punch In and Punch Out function enables you to track the time spent assisting a customer for each ticket. When you
click the Punch In button on a ticket's detail view, Infor CRM SLX begins timing the activity. When you are finished, you can
click Punch Out. Infor CRM SLX stops timing the activity and adds an activity record to the Ticket Activities tab for the ticket.

When you use the Punch In/Punch Out feature in a ticket, a timed activity is
automatically created.

Our scenario:

Tom Dale calls with more information on his printer problem. You need to open the ticket and track the time you spend
talking to him and gathering information.

To punch in to and out of a ticket

1. From the Beeker Motors Account Detail view, click the Tickets tab, and click the ticket’s Ticket ID number.

2. Click the Punch In button.
The button text changes to Punch Out, and Infor CRM SLX begins recording time against the ticket activity.

Click the Ticket Activities tab. If the tab is not visible, click the More Tabs tab.

From the list of ticket activities, click Edit next to the Timed activity you want to change.
Enter the information from your conversation with Tom Dale in the Comments.

Click Save.

When you are finished working on the ticket, click Punch Out to stop tracking time on the ticket.

N o g ko

Closing a Ticket

The stage at which a ticket is closed and the person responsible for closing a ticket depend on your company’s processes.

Our scenario:

You resolved the problem with Tom Dale’s printer and completed all follow-up activities. Now you want to close the
ticket.

To close a ticket

1. Open Tom Dale's ticket.

2. Ensure all ticket information is complete and accurate.

3. Close any open ticket activities.
a. Click the Ticket Activities tab.
b. Click Edit next to the Research activity.
c. Click the End Date Calendar button, select a date, and then click OK.
d. Click Save.

4. Inthe Status box, click the drop-down arrow, select Closed, and then click OK.

Click the Details tab and update the Resolution.

a. Click the Date/Timestamp button.

b. Type Printer overheats and turns off due to faulty fan.
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6.

If you want to submit the resolution information to be accepted into the SpeedSearch indexes, select the Submit for
SpeedSearch check box in the top pane.

7. Click Save.

Working with Returns

Returns are agreements to accept returned products from a customer for service, replacement, refund, or credit. This may
also be referred to as an RMA or Return Materials Authorization.

Adding a Return

Every return must be associated to a ticket. Before you add a return, ensure that the related ticket exists. If necessary, create
the ticket before proceeding.

Our scenario:

Tom Dale reported a problem with a printer and sent it in for repairs. After researching the ticket, you determined that
the printer must be replaced.

To add a return

1.

© N o o & w DN

11.
12.

13.
14.

Open Tom Dale's ticket.

Click the Returns tab. If the tab is not visible, click the More Tabs tab.
Click the Insert New Return button.

Verify that the Ticket ID, Account, and Contact are correct.

In the Reason box, type Printer overheats.

In the Customer PO box, type the customer purchase order.

Click the Status drop-down arrow and select Return Received.

Click the Type drop-down arrow and select Send Replacement.

Click the Priority drop-down arrow and select Next Day.

In the Expected By box, click the Calendar button, and select this Friday.
Click the Assigned to Find icon and use the lookup to find and select your name, and then click OK.

Click Save.
The Return Detail view opens.

Click the Ship To Details tab. If the tab is not visible, click the More Tabs tab.

Verify the contact and address information is for Tom Dale at Beeker Motors.
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Adding Products and Shipping Details to a Return

You add products to a Return to indicate which product the account is returning, and which is the replacement product to be
shipped to the customer.

Our scenario:

You added the return for Tom Dale's ticket and now want to add the product asset that Tom is returning.

To add an asset to a return

o > v bnh =

Open the detail view for the return you created for Tom Dale's printer.
Click the Details tab. If the tab is not visible, click the More Tabs tab.
In the Assets to Return section, click the Associate Asset button.
Locate and select the NetPrinter Laser Elite printer using the lookup.
Click OK.

To update the shipping contact information

1.

N o g s~ e Db

On the Return detail view, click the Ship To Details tab. If the tab is not visible, click the More Tabs tab.
Verify that Tom Dale is the Ship To contact.

Use the Carrier and Tracking # boxes to include additional shipping information.

In the Attention box, type Tom Dale.

Verify that the address information is correct.

Type any special shipping instruction in the Special Instructions box.

Click Save.

To add the products to be returned and replaced

1.
2.

Under Assets to Ship, click Add Return Shipped Product.

In the Add Return Shipped Product dialog box, under Received Product, click the Find button, select NetPrinter
Laser Elite printer, and then click OK.

Select Return Existing.
The returned product is automatically added.

Click the Shipped Date Calendar button and select today's date.
Click OK.

e For more information see the "Using the Return Ship To Details Tab" topic in the Infor CRM SLX Web

Client Help.
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Closing a Return

The stage at which a return is closed and the person responsible for closing the return depend on the process within your
company. As an example, when the product has been returned by the customer and the replacement product has been
shipped, that might be the stage at which you would close a return.

Our scenario:

Now that Tom Dale's replacement printer has been shipped to him, you want to close the return.

To close a return
1. Open the detail view for the return you created for Tom Dale's printer.
2. Inthe Status box, click the drop-down arrow, and then select Closed from the list.
3. Click Save.

Working with Defects

A defect is a record describing a problem in a product or process. It is similar to a ticket, but people involved in the design or
construction of the product typically resolve defects. The system tracks defects so that problems with a product or process
can be resolved in a timely manner, and company management is aware of issues with these products or processes.

Adding a Defect to an Existing Ticket

When you discover a problem in a product or process, you can add a defect to Infor CRM SLX.

Our scenario:

After receiving Tom Dale’s printer you discovered that there is a problem with the cooling fan. You need to enter a
defect to track the problem.

To add a defect to an existing ticket
1. Open Tom Dale's ticket.
Click the Defects tab. If the tab is not visible, click the More Tabs tab.
Click the Create Defect button.
Click the Project drop-down arrow and select Hardware.
In the Version Found box, click the drop-down arrow,and select 1.
In the Target Version, click the drop-down arrow, and select 2.

Leave the Status as Open.
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In the Current Progress box, click the drop-down arrow, and select Customer Return.
9. Inthe Priority and Severity boxes, click the drop-down arrow, select the importance and impact of the issue.
10. Inthe Frequency box, click the drop-down arrow,and select Weekly.
11. Inthe Type box, click the drop-down arrow, and select Power.
12. Inthe Area box, click the Find button and in the Area list select Hardware.
13. Inthe Category list, select Printer.

14. Inthe Issue list, select Power, and then click OK.
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15.
16.
17.
18.
19.
20.

21.

Select the Submit for SpeedSearch option so that this issue can be found using SpeedSearch.
In the Public Access box, select 5-internal.

Click the Assigned To Find button , select your name from the list, and then click OK.

In the Source box, click the drop-down arrow, and select Parts.

In the Subject type Printer fan stops and printer overheats.

In the Description box, click the User Date Stamp button, and then type Cooling fan stops which causes the
printer to overheat and turn off during a print job.

Click Save.

Closing a Defect

The stage at which a defect is closed and the person responsible for closing the defect depend on the process within your
company.

Our scenario:

The problem with the NetPrinter Laser Elite fan has been identified. You are ready to add a resolution and close the
defect.

To close

1.

2
3
4.
5

Open the defect you created for the NetPrinter Laser Elite.

In the Fixed in Version box, click the drop-down arrow and select an item from the list.
In the Status box, click the drop-down arrow, and then select Closed.

Click the Details tab.

In the Resolution box, click the User Date Stamp button, and then type Fan is too small. Any printers
experiencing this problem should be returned and the fan will be replaced.

Click Save.
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Chapter 8
Using Web Reporting and Analysis Tools

Infor CRM SLX includes reporting and analysis tools that help you identify opportunities, guide you through interactions with
a customer, and evaluate sales effectiveness.

The Reports List view provides a list of pre-defined sample reports to enable you to view and analyze information in the Infor
CRM SLX database. You can run reports related to Main views such as Contact, Account, Opportunity and so on. If you
prefer, you can modify the report to accommodate your business needs. The specific reports available to you are determined
by your system administrator.

Customer journeys guide users through interactions with a record, for example an opportunity or contact, and provide a
graphical representation of the stages of a customer journey.

The Dashboard is a tool set that allows you to display and interact with a variety of performance and analysis information in a
dashboard format. You can use the data provided to gain insight into organizational and individual performance, discover
root causes for performance issues, and then take the corrective actions or make strategic decisions.

In this chapter, you will learn to:
®  Use the Reports view
®  Run areport
= Export and print reports
= Work with Dashboards

= Use Dashboard widgets

Using the Reports View

Reports enable you to view information about contacts, accounts, opportunities, tickets, and other related data.

The Reports view allows you to select from a list of available sample reports and apply filters to narrow the results. You can
only access reports that have been released to you by the system administrator. Reports can be released to you personally,
or to a team that you are a member of. When you view or print any report, only records you have access to are included in
the report.

Our scenario:

You want to run a report listing all the interactions you have had with your contacts.

To run a report
1. Onthe Navigation Bar, click Reports.

2. Inthe Report list view, Reports tab, select the Contact Summary - Sample report, right-click, and then click Run
Report.
This is the option for reports you want to run only once, or reports you require immediately.

3. Inthe Select Records dialog box, in the Show records that match box, pick All Records.

Getting Started with the Infor CRM Web Client | 77



Chapter 8 Using Web Reporting and Analysis Tools

4. Click Next.
In the Enter Values dialog box do the following:
= |eave View Notes as Yes.
®  Use the pick list to change Start each contact on a new page to No.
6. Click Next.
7. Inthe Export Options dialog box, use the pick list to select PDF as the file format for your report.

8. If you selected Schedule in step 1, you can create a job schedule for running your report. Select from the available
scheduling options.

Click Finish.
10. When the progress message box appears, do one of the following:
= Wait for the job to complete and open your report from the link that displays.

= Click Close to dismiss the box. The report continues to process in the background. When the report is
available, a job notification alert appears in the menu bar. You can either view the report from the Job
Notifications box or from the Reports History tab.

Viewing, Printing, and Storing Reports

When you run a report, it is stored in the Reports History tab until you choose to delete it. From this tab you can see history
for the report, open the report, print, save the report elsewhere, or store the report for future reference.

To find the Report History tab
1. On the Navigation bar, click Reports.
2. Inthe Report List view, click the History tab.

To open a report

= |n the Report History tab, in the Report column, click the report name.
The report opens in the native application for the report file type.

To print or save the report

= Use the tools available in the native application.

To delete a report
1. Inthe Report History tab grid, select the report.
2. Right-click and then click Delete.

Using Customer Journeys

Customer journeys are a series of stages and steps to guide users through interactions with a record, for example an
opportunity or contact, and provide a graphical representations of the stages of a customer journey.

Stages group steps together. Each stage shows the stage name and the percentage probability of completing the customer
journey successfully when the stage is completed. Steps are the actions that will complete the stage. For example, the steps
in a stage called Demonstration might include steps for Demonstration Preparation, Product Demonstration, and
Demonstration Thank You email.
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You can use the Customer Journey tab on some detail views to select and start a customer journey and track your progress
by performing and completing steps and stages. On the Dashboard, the Customer Journey Kanban widgets allow you to
view a list of the records in each stage of a selected customer journey as well as roll-up statistics in each stage.The Account
detail view Customer Journey 360 tab provides an overview of all of the customer journeys for the account and customer
journeys for related contacts, converted leads, opportunities, quotes, sales orders, and tickets.

Customer journeys are created and managed by the administrator.

Starting and Performing a Customer Journey

The Customer Journey tab is available on the Contact, Account, Lead, and Opportunity detail views.The tab consists of a
graphical representation of the stages as well as statistics at the top and a check list of stages and related tasks below. A
record can have multiple customer journeys at one time. The Customer Journey tab is available on the Contact, Account,
Lead, and Opportunity detail views.

Customer journeys are only available if created by your administrator.

Customer Journeys for a converted lead are available in the new contact’'s Customer
Journey tab, but are read-only.

To start a customer journey
1. On a detail view click the Customer Journey tab. If the tab is not visible, click More Tabs.
2. Click the Customer Journey drop-down arrow and select from the list.
The stages and steps, as well as statistics for the selected customer journey display.
3. Click Start.

Once a customer journey is started, the Start button is replaced with statistics for the current stage of the selected
customer journey.

Working through a customer journey

Once a customer journey is started, you can do the following:
= View status and statistics.
= Per customer journey
o Current Stage

» Stage Estimated Completion — The estimated date the stage will be completed based on the stage start
date and the number of estimated days in the stage.

« Customer Journey Estimated Completion — The estimated date the customer journey will be completed
based on the sum of the estimated days in the stages that have not been completed.

= Perstage

« Estimated Days in Stage — The expected number of days it will take to complete the stage as specified
for the customer journey.

« Actual Days in Stage — The number of days between when the stage started and closed.
« Close Probability — The probability of completing the customer journey successfully.

= To perform a step, click the Step link. The action depends upon the action type which is identified by an icon. Some
action options may have already been defined by the administrator.

Getting Started with the Infor CRM Web Client | 79



Chapter 8 Using Web Reporting and Analysis Tools

Step Description
Action

Mail Opens the Mail Merge dialog box.
Merge

Once the mail merge completes, the link will do one of the following:
= |f merged to afile - opens the .zip file that contains the merged documents.

= |f merged to an email — displays a message asking if you want to perform the mail merge
again.
' Meeting Opens the Schedule Meeting dialog box.

Once scheduled, the link will open the scheduled activity to view or edit or completed activity.
| .q_/’ None This step does not contain an action.

E] Notes Opens the Insert Note dialog box. Once saved, the link opens the note to view or edit.

Phone  Opens the Schedule Phone Call dialog box. Once scheduled, the link will open the scheduled
Call activity to view or edit or completed activity.

\/’ To-Do Opens the Schedule To Do dialog box.

Once scheduled, the link will open the scheduled activity to view or edit or completed activity.
u._:': Workflow A message displays that workflow was started.

Once started, the link will display a message asking if you want to start another instance of the
workflow.

= To complete a step, select the check box in the column next to the step name.

U You cannot complete a step if a previous required step is not completed.

® To complete a stage
®= Do one of the following:
« Select the check box in the column next to the stage name.

» Complete all steps within a stage. Once the checkboxes for all steps in a stage are selected the stage is
automatically completed.

U » You cannot complete a stage if any required steps are not
completed.

« Completing stages out of order may cause unexpected results in the
Customer Journey heading information.

Using the Account detail view Customer Journey 360 tab

Use the Account detail view Customer Journey 360 tab to view a graphical representation of all started customer journeys for
the account and any associated contacts, converted leads, opportunities, sales orders, quotes or tickets associated with the
account.

To open the customer journey 360 tab:

= On the Account detail view, click the Customer Journey 360 tab.
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On this tab you can:

® Use the scroll bar to scroll up and down

= Use your mouse wheel to zoom in or zoom out

= Click the Reset Zoom button to reset the zoom.

= Click and drag to move along the time line or to reposition the customer journeys

= Filter the customer journeys that display in the tab.

Click the Filters Maximize icon to display the filter options.
Clear or select the check boxes to determine the types of customer journeys to display.

Select the Filter by date range check box and use the From and To options to define a date range by
specifying a number, selecting a time frame, and then, if necessary, clicking the Calendar icon to select a date.
For example:

From: 2 years before 01/01/2024 To: 1 year after 01/01/2025.

Click Apply to apply the filters.

Click the Filters Minimize icon to hide the filter options.

= View Customer Journey information:

Type
Name
Alink to the record associated with the customer journey

Expected Complete or Completed date and if the customer journey progress is on schedule, running late, or
running early.

Click the customer journey bar to open the Customer Journey details dialog box.

= View the started stages of a customer journey

The customer journey bar extends from the started date to the expected complete date or completed date if the
customer journey is complete.

Started stages display as colored bars from the stage start to end date.

= View the started steps for a customer journey

Hover over an icon to see limited details.

Click the icon to open details of the step
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Working with the Dashboard

The Dashboard allows you to display and interact with a variety of performance and analysis tools. You can maintain one or
more personalized dashboard tabs and, with the appropriate permissions, you can modify dashboards provided by Infor
CRM SLX or customized by your administrator.

You can format the data on the dashboard using widgets to gain insight into organizational and individual performance
including the ability to measure multiple metrics in the same widget. A widget is a dynamic, reusable element of the interface
that displays the data you specify. The data can be visualized in a pie or donut chart, gauge (speedometer), bar or column
chart, pipeline, or line graph, or you can view the detailed data in a list. For more information about widgets, see "Working
with Widgets" on page 83.

There are three out-of-the-box dashboard tabs: My Dashboard, Sales, and Samples. Each tab has several out-of-the-box
widgets. You can add and edit widgets to display different data or display the same data in different ways.

To open the dashboard

= On the Navigation Bar, click Dashboard.

Customizing Your Dashboard

Use the context menu on a dashboard tab to add a new tab, copy, hide/show and delete tabs, or share tabs with your team or
department. Use drag-and-drop to rearrange the widgets on the tab. Widgets automatically size to fit the data and chart type,
as well as the column size.

You can also send all the data for a group from a list view to a group list widget on the dashboard with the Promote to
Dashboard link on the list view Tasks Pane.

To add a new tab

1. Onthe Dashboard menu, click New Tab.
To open the Dashboard menu, click the three lines in the upper right-hand corner.

2. Inthe Name box type a name for the tab
3. Click Save.

To share a tab with other users

1. Onthe Dashboard menu, click Share Tab.
To open the Dashboard menu, click the three lines in the upper right-hand corner.

2. Do one of the following:
®  To add users, departments, teams or everyone:

a. Click the Add button in the Share Tab window.
The Share with window is displayed.

b. Click the Share with drop-down arrow and select the user, department, or team to share with.
c. Click Save.

d. Repeat steps athrough c for each user, team, or department you want to share the group with.
e. When finished, click Share.

®  To change a user, department, or team:
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a. Click the Edit icon for the user, team, or department to be modified. The Share With window is
displayed.

b. Select the user(s).
c. Click Save.
d. Repeat steps a through c for each user, team, or department you want to edit.
e. When finished, click Share.
®  Toremove a user, department, or team:
a. Click the Delete icon for the user, department, or team to be removed.
b. Click Save.
c. Repeat steps a through c for each user, team, or department you want to remove.

d. When finished, click Share.

To promote a group to a dashboard

1. From alist view, click the group tab you want to send to the dashboard.

2. Inthe Task Pane, click Promote to Dashboard.

3. Click the name of the dashboard where you want to send the data, and click OK.
4. Click OK.
5

Click Welcome in the Navigation Bar and select the dashboard tab you selected in step 3.
The data appears on the dashboard in a group list widget. The default configuration for the group listis 10 lines;
however you can change this in the widget editor to display up to 50 lines.

Working with Widgets

Widgets are plug-ins you can add to a dashboard. There are several types of widgets you can use to display your data. Move
your mouse over the chart in a widget to display the dimension and metric selected for that widget.

There are several types of widgets:

U The list of available widgets is determined by your implementation. You may not have
access to all widget types.

®  Charting - Bar, Bubble, Column, Donut, Funnel, Gauge, Line, and Pie charts
® Other - Group List, Links, SData Feed, and Infor CRM SLX Welcome

Using Widgets

You can add, edit, and delete widgets from the dashboard, and you can reorder widgets on the page with drag-and-drop.

Our scenario:

You want to show potential revenue of opportunities in your pipeline for each level of revenue.

To add a funnel chart widget

Right-click a Dashboard tab and click Add Content.

Click the Add button under Funnel Chart.

Type a Title for the funnel chart, for example Open Opportunities by Sales Potential.
In the Entity list select Opportunity.
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In the Group list select All Open.
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In the Dimension list select Stage.
In the Metric list select Sum Sales Potential.
Determine if you want to Display Labels, Truncate Labels and what the Label Length is.

Click OK.
A range of sales potential amounts displays with each sales potential range represented as a different colored level.
The size of each level represents the number of opportunities within a particular sales potential range.

To edit a widget

Find the widget you want to edit and click the Settings@ button to open Widget Settings.

Make the required changes.
Options are the same as tadding a widget and depend on the widget type.

Click Save.
The widget displays the changes.

To delete a dashboard widget

1.
2.

3.
4.
5.

Click Dashboard on the navigation bar.

Select the tab that contains the widget to be delete.

Find the widget and click the Settings@ button to open Widget Settings.
Click Delete.

Click OK to confirm the deletion.
The widget is permanently deleted from the dashboard.

To reorder widgets on a tab

1.

2
3.
4

On the Navigation bar, click Dashboard.
Select the tab you want to change.
On the Dashboard menu, click Reorder Widgets.

Drag and drop the widgets into the desired position.

The order is presented in a single column, but when finished multiple widgets
may display on the same row depending upon the widths set for each widget.

Repeat until you have designated the desired order of widgets.

When finished, click Finish.
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Working with List View KPlIs

The list views contain Key Performance Indicators, or KPIs. The KPIs are based on the current list of records,the group and
any applied filters. Some KPIs can be specific to a subset of data, for example in theOpportunities list view, a KPI for
Average Actual Amount can be calculated using the actual amount for allclosed-won opportunities in the list and a count of
closed-won opportunities.

The list views display KPlIs if at least one KPl is selected. These list views contain out-of-the-box KPls to select from:
= Accounts
= QOpportunities
= Quotes
= Sales Orders
= |nvoices (Infor CRM SLX Back Office only)
= Contracts
® Returns

= Tickets

Managing List View KPIs

To manage list view KPIs

1. Click the Manage KPIs'n' icon on the list view.

2. Select the check boxes of the required KPIs to show and clear the check boxes of the KPIs to hide.

Selecting a large number of KPlIs to display can increase the loading time for
KPIs and decreasethe amount of horizontal space for each KPI.

3. Click Save.
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Chapter 9
Setting User Options

Infor CRM SLX provides tools to allow you to modify some parts of the interface so that you can work in the way that suits
you best. Your settings that you enter are recorded for you and are not visible to other Infor CRM SLX users.

General Options

Use the General tab to specify such settings as which view opens by default when you first log into Infor CRM SLX Web
Client, and who to use as the default owner for any new records you create.

To set general options

1.
2.
3.

10.

11.

12.

On the Tools menu, click Options.
Click the General tab.

In the Show on Startup box, select the default view you want to display when you log in to the Web Client, (for
example, What's New or Calendar).

In the Default Owner/Team box, click the Find button, select the user or team you want to be the default owner for
new accounts, and then click OK.

For Multi-Currency only: To select a currency type, click the My Currency Find button, select a currency from the
list, and then click OK.

If you need updated pick list data, click the Refresh Pick List Data button.
You should only click this button if there are updated pick list items available.

If you want to be notified when you have unsaved changes on a page, select the Prompt for unsaved data check
box. This option is selected by default. Clear the check box if you do not want to be notified.

Select the Default Username/Time Stamp in Memo Fields if you want to have the option to click the User Date
Stamp button to add your name, the date, and time (according to your language settings) to a memo box.
This option will only work on memo boxes on which your administrator has turned on this feature.

Select the Display List view check boxes option if you want all of your list views to include a column of check
boxes.

If you want to be automatically logged out of the Infor CRM SLX Web Client after a period of inactivity, select the
Enable Automatic Logoff option, and then under Log off after type the allowable number of minutes of inactivity.

Click the Contact Sync Group drop-down arrow and select the ad hoc contact group that will contain the contacts to
synchronize. If the ad hoc group you want to sync your contacts to does not appear in the list, you must first create
the group.

Do not select a contact sync group if you are only synchronizing with Outlook using Outlook sync. If you are using
Outlook sync, see "Configuring the Contact Sync Group" in the Infor CRM SLX Web Client Help.

In the Log to History box, select Prompt if you want the Complete E-mail dialog box to display after you drag and
drop an e-mail message. If you want the message to be recorded to history without prompting, select Do Not
Prompt.
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13.
14.

15.

16.

""" This option only applies to dragging and dropping e-mails. You must set options
for Send to CRM and Record to History in Outlook. See "Configuring Outlook
Integration" on page 26.

To install Infor CRM SLX Xbar for Microsoft Outlook, click Install Xbar for Outlook.

To install the Mail Merge for Microsoft Word add-in, click Install Mail Merge for Microsoft Word. For more
information, see "Understanding Infor CRM SLX Mail Merge for Microsoft Word" on page 22.

For Offline Web Client users only: To run reports while see target, ensure the Use ActiveReporting check box is
selected.

Click Save.
You must click Save on each tab or your option selections will not be saved.

Group Options

Use the Groups options tab to determine how your groups, list views and lookups will appear and behave. These options
only apply when the current user is signed in to the Infor CRM SLX Web Client.

To set group options

1.
2.
3.

4.

On the Tools menu, click Options.
Click the Group tab.
Set your Group Options.
a. Click the Main View drop-down arrow and select a view from the list.

b. Click the Default Group drop-down arrow and select a default group from the list. For example, Latest
Contacts.

""" o The default layout for new groups is determined by the group
selected as the default group.

« If your default group does not display as a tab, you must mark it as a
Favorite in the Groups list.

c. Click the Default Lookup Layout drop-down arrow and select the name of the group with the layout you want
to see for any lookups on that main view. For example, on the Contact views, all lookups will use the Latest
Contacts group layout.

The group you select will also determine what search items are available in the Lookup. The Lookup by options
depend on the columns included in the layout of the lookup. You should choose a group that includes all of the
columns you may want to search by in a lookup.

d. Repeat steps a-c for each main view.

Under General Lookup Options, click the Default Lookup Condition drop-down arrow and select the lookup
condition you would like to use for all list view lookups. Options include: Starting With, Contains, Equal to, and Not
Equal to.

Click Save.
You must click Save on each tab or your option selections will not be saved.
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Calendar Options

Calendar Options allow you to adjust the content and appearance of your calendar to accommodate the way you work. You
can set the type of information that displays in activities, the start and end of the work day, the default calendar view, default
interval on the calendar, and whether or not completed activities (history) items display. History items only display on the day
and week calendars by default.

To set calendar options

1.
2.
3.

10.

11.

12.

13.

On the Tools menu, click Options.
Click the Calendar tab.

In the Default Calendar View box, click the drop-down arrow and select the default calendar view you want to
display when you open the Calendar view.

In the Number of Events on Day/Week box, click the drop-down arrow and select the maximum number of events
that you want to display in the top part of the Calendar Day and Week views.

In the Show History On Calendar box, click the drop-down arrow and select Yes to display history items or No if
you do not want history items to display on the Calendar Day view.

In the Remember Selected Users, click the drop-down arrow and select Yes if you display multiple users on your
calendar view and want to save the list of users between sessions.

Under Work Week, select the days of the week that are included in your work week.
In the First Day of the Week box, click the drop-down arrow and select the day on which your work week starts.
Set the following options to customize your calendar:

a. Day Start - Select the time that your workday begins.

b. Day End - Select the time that your workday ends.

c. Default Interval - Select whether the calendar displays information in 15, 30 or 60 minute intervals.

Contact/Account - Select how you want contact and account information to display on the Calendar. This option
does not apply to the month view.

Set the Show on Activities options to define how activities are displayed on the Calendar timeline for day and week
views. These options do not apply to the month view.

= Opportunity - Displays an activity's opportunity information, if applicable, on the day and week calendar views.
= Phone Number - Displays an activity's phone number information on the day and week calendar views.

= Regarding - Displays an activity's regarding information on the day and week calendar views.

= Time - Displays the activity's start and end times on the day and week calendar views.

Default Activity Type - Select a default activity type. This is the type of activity that will be created when you double-
click on any of the Calendar views.

Click Save.
You must click Save on each tab or your option selections will not be saved.

Changing Your Password

You can change your password through the Options in the Infor CRM SLX Web Client.

To change your password

1.
2.
3.

On the Tools menu, click Options.
Click the Change Password tab. type your password in the Current Password box.

In the New Password box, type your new password.
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4. Retype your new password in the Confirm Password box.
5. Click Save.
Opportunity Options

Use the Opportunities tab to specify default settings for any new opportunities that you enter into the Infor CRM SLX Web
Client. These options only apply when the current user is signed in to the Infor CRM SLX Web Client.

To set opportunity options

1.
2.
3.

11.
12.

13.

17.

On the Tools menu, click Options.
Click the Opportunities tab.

In the Opportunity Description area, select Use default name conventions if the default names will be controlled
by a script.

A sample Opportunity Description will appear in the space below the check box. Contact your administrator if you are
unsure whether or not you should select this item.

To set the estimated close date for the new opportunities you create, under Use this Estimated Close Date, select
the number of months in the Set estimated close date to x months after opening drop-down list. You can select
from 0 to 36.

If you want opportunities to close at the end of the month selected in the preceding step, select the Initially change
estimated close to last day of month check box.

In the Opportunity Status box, click the drop-down arrow and select from the list. (The default setting is Open.)
In the Opportunity Type box, click the drop-down arrow and select from the list. (This setting is blank by default.)

From the Probability drop-down list, click the drop-down arrow and select a probability of close that will be the
default for new opportunities. This option is ignored if you choose a default Sales Process in step 9.

To automatically include new opportunities in forecasts, select the Add to Forecast check box. Clear this check box
if you do not want to automatically include new opportunities in forecasts. You can also manually select the Add to
Forecast check box when adding or editing an opportunity.

For Multi-Currency only: Click the Default Currency Find button to select from the list.

Select a process from the Sales Process list. The list consists of all released sales processes. The default setting is
blank.

""" The Default Sales Process box will be unavailable if the SalesLogix Advanced
bundle is not installed.

In the Default Contact(s) area you can determine which contacts should be added to new opportunities by default.
Default Contact options are:

« Add all contacts associated with account
o Add only the account's primary contact
+ Add no contacts

Click Save.
You must click Save on each tab or your option selections will not be saved.
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User Profile Options

Use the User Profile options tab to determine how the Infor CRM SLX Web Client will appear and behave. These options
only apply when the current user is signed in to the Infor CRM SLX Web Client.

If Infor Infor OS single sign-on is configured, Infor CRM language settings will be based
upon the browser language settings, not the User Profile, Language Selection. Infor
CRM SLX recommends making sure that both the browser and Language Selection
are the same to ensure an optimal experience.

To set user profile options

1.
2.
3.

On the Tools menu, click Options.
Click the User Profile tab.

If necessary, change the language setting.

Changing the language will cause the Infor CRM SLX Web Client to display in your selected language. If you do not
select a language, then the Infor CRM SLX Web Client will use the default language. The list of languages is based
upon the languages supported by your organization.

= Click the Language Selection drop-down arrow and select a language from the list.
Select a regional format in the Regional Format field.
For more information on Regional Formats, see the Web Client help topic "Using Regional formats".

Click Save.
You must click Save on each tab or your option selections will not be saved.

Alerts Options

Use the Alerts tab to set defaults to determine how you will be alerted for alarms and new unconfirmed activities.
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To set alerts options
1. Onthe Tools menu, click Options.
2. Click the Alerts tab.

3. Select Display in toolbar if you want Alerts to appear in your toolbar

""" If you do not select this option, then the remaining check boxes will be
unavailable and you will not be notified of your Alerts.
4. Select Prompt for Alerts if you want the Alerts dialog box to display when you have new alerts.

5. Under to Include, select the information you want to include in your Alerts. If you selected Prompt, this is the
information that will cause the Alerts dialog box to open:

""" If you do not select any options, and you selected to display or prompt for
Alarms, then your Alerts will be empty and will not prompt.
= Select Alarms if you want your alarms to display in your Alerts.
= Select Unconfirmed Activities if you want your unconfirmed activities to display in your Alerts.

6. Click the Default Snooze drop-down arrow and select from the list to set the default amount of time to postpone an
activity alarm. You can still change the snooze time from the Snooze list before you snooze your alarms.

7. Click Save.
You must click Save on each tab or your option selections will not be saved.
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Activities Options
Use the Activities tab to set defaults such as activity type.

To set activity options
1. Onthe Tools menu, click Options.
2. Click the Activities tab.

3. Inthe Default Follow-up Activity drop-down list, select the type of activity to be scheduled as a follow-up, after you
complete an activity.

4. Inthe Carry Over Notes drop-down list, select Yes if you want to carry over any existing notes. when you schedule
a follow-up activity.

5. Inthe Carry Over Attachments drop-down list, select Yes if you want to carry over any existing attachments when
you schedule a follow-up activity.

6. Select Display Past Due in the toolbar if you want to be notified of past due activities.
7. Do one of the following:

= Select Show history for all participants if you want history records for all activity participants to display in the
detail views Notes/History tab.

= Clear Show history for all participants if you want history records for only the primary participant to display in
the detail views Notes/History tab.

8. Under the Defaults Per Activity Type section, set the Default Alarm and Default Duration for each activity type:

a. Click the Default Alarm drop-down arrow and select from the list to set the default alarm when scheduling a
new meeting.

b. Click the Default Duration drop-down arrow and select from the list to set the default duration when scheduling
a new meeting.

c. Selectthe Default Timeless option if you want an activity to be timeless by default.

d. Ifyou selected the Default Timeless option and you want activities to automatically rollover to the next day if
they are not completed on the scheduled date, then select the Auto Rollover option.

You can only rollover timeless activities.

e. Repeat steps a-d for Phone Call, To Do, and Personal Activity.

9. Click Save.
You must click Save on each tab or your option selections will not be saved.

Setting Customer Service Options
Customer Service Options allow you to set options like date and time stamp settings and time tracking options.

To set customer service options
1. Onthe Tools menu, click Options.
2. Click the Customer Service tab.
3. Under Time Tracking, do the following:

a. Ifyou are required to track your time when processing new issue, select Automatically Punch In to a new
Ticket.
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b. If you are required to track your time when processing and resolving existing issues, type the number of
minutes in the Prompt to Punch In to an existing Ticket text box.

c. Select Display Ticket Activity on Punch Out to automatically display the Edit Ticket Activity dialog box for
you to enter activity information when punching out of a ticket.

d. Select Display Ticket Activity on completion of Calendar Activity (WIndows version only) to
automatically display the Edit Ticket Activity dialog box for you to enter the activity information for a completed
calendar activity.

The Display Ticket Activity on completion of Calendar Activity (Windows
version only) option only applies to the Windows Client

4. Click Save.

Multi-Factor Authentication Options

Use the Options, Multi-Factor Authentication tab to add, edit, or delete your Multi-Factor Authentication (MFA) method
methods. The available methods depend upon what is allowed by your administrator.

If you plan to use an authenticator application you must first have access to that
application on your mobile device.

To manage Multi-Factor Authentication options:
1. From the Tools menu, click Options.
2. Click the Multi-Factor Authentication tab.
3. View the list of Multi-Factor Authentication methods you have already created.
4. Click Insert New Item to add a new method.
a. Click Insert New Item to add a new method.
b. Inthe Name box type a descriptive name for your authentication method.

c. Selectls Default if you want this to be your default authentication method.
This will clear the Is Default from the authentication method previously designated as the default.

d. Click the Authentication Method drop-down arrow and select from the list. The options available depend on
what your administrator has implemented, but may include:

o Email
« Authenticator Application
e. Click OK.
5. To edit an existing method, select the method in the list and click Edit Selected Item.
a. You may modify either of the following:
« Name - the descriptive name for your authentication method.

« Is Default — Identifies the default authentication method.
If selected, Is Default is cleared from any authentication method previously designated as the default.

b. Click OK.

6. Todelete a method, select the method in the list, click Delete Selected Item, and then click OK to confirm the
deletion.
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